
Örebro universitet   
Akademin för naturvetenskap och teknik 
Oru-Te-2009-87 
 

 
 

 
 

 
 
 

Datoranvändning 
 

HT09 
 

 
 



Datoranvändning Innehållsförteckning JPZ 

 1

Innehållsförteckning 
 

 
Nätverket TEKNAT ................................................................................................................... 2 

Windows (OH) ........................................................................................................................... 3 

Övningar i Windows .................................................................................................................. 6 

Word (OH) ................................................................................................................................. 8 

Word – Sammanfattning .......................................................................................................... 21 

Rapportskrivning (OH) ............................................................................................................ 32 

Övningar i Word ....................................................................................................................... 41 

PowerPoint (OH) ...................................................................................................................... 54 

Övning i PowerPoint ................................................................................................................ 60 

Excel (OH) ............................................................................................................................... 62 

Excel – Sammanfattning .......................................................................................................... 76 

Övningar i Excel ....................................................................................................................... 83 

Python ....................................................................................................................................... 89 

Övningar i Python .................................................................................................................. 100 

MatLab (OH) .......................................................................................................................... 104 

MatLab – Kort instruktion ...................................................................................................... 113 

Övningar i MatLab ................................................................................................................. 121 

Maya ....................................................................................................................................... 127 

Övningar i Maya ..................................................................................................................... 130 

Redovisning ............................................................................................................................ 132 

 

 
 
Jag tackar mina högt värderade kollegor Sigvard Aune (SAE), Sune Bergelin (SBN), Jonas 
Karlsson (JKN) och Lennart Schön (LSN) för bidragen. Det framgår av respektive sidhuvud 
vem som är författare. Kompendiet används i kursen Datoranvändning och datorteknik  
(7,5 högskolepoäng) för de datatekniska programmen. 
 

Jack Pencz (JPZ) 
 
 



Datoranvändning Nätverket TEKNAT JPZ 

 2

Nätverket TEKNAT 

Nätverket 
 
Nätverket TEKNAT används av exempelvis ingenjörsprogrammen vid Örebro universitet. 
Varje teknikstudent får ett konto på TEKNAT. Detta konto preciseras av ett användarnamn 
(user), ett lösenord (password) och rättigheter till resurser. Du kommer att få tillgång till en 
personlig katalog (mapp) på TEKNAT. Enheten med den personliga katalogen brukar kallas 
M: och den katalog som är avsedd för personligt bruk är M:\Pcsa. 
 
Ibland använder lärarna StudCommon på TekNat\Stud$\share (N:) för att enkelt kunna dela 
ut filer till studenterna. Även kurssidorna på Blackboard (http://trana.oru.se) kan användas för 
detta syfte. 
 
I datasalarna används persondatorer med någon version av Windows. 
 

Lösenorden 
 
Eftersom det alltid finns en risk att någon oärlig person försöker lista ut dina lösenord, bör det 
vara tillräckligt många tecken i dessa. Ju fler tecken, desto svårare att ”knäcka”. På TEKNAT 
måste lösenordet bestå av minst sju (7) tecken. Dessa tecken ska komma från minst tre av 
följande fyra grupper: 
 

1. Engelska versaler (A till Z)  
2. Engelska gemener (a till z)  
3. Siffror (0 till 9)  
4. Ickealfanumeriska tecken (t.ex. !, $, #, % och svenska specialbokstäver)  

 
 
Vid problem, ta kontakt med Studentcentrum. 
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Övningar i Windows 
 
Dessa uppgifter är avsedda för Dig som känner Dig mindre van vid Windowsmiljön i 
persondatorer (PC) eller behöver repetera användning och begrepp. 
 

Hjälpfunktioner  
a) Orientera Dig om de olika avsnitten i Windows basics (finns under Help and Support, 

klicka på start.   
 
b) Skaffa dig en översikt om innehållet genom att bläddra i listrutan eller skriv in sökord (in 

English). Observera att innehållet i listrutan förändras i takt med att du skriver in 
sökordet.  

 

Utforskaren 
a) Starta Explore (Utforskaren). Skapa en mapp med namnet Slask i Din hemkatalog 

(användarmapp) som hör till ditt konto i nätverket. Hemkatalogen är M:\Pcsa. Minimera 
Explore. 
 

 
b) Starta Notepad (All Programs/Accessories). Skriv något fördelaktigt om vädret och 

spara filen med namnet soligt i mappen ovan. 
 
Vilket filtillägg (extension) får den? _______________________ 
(Filtillägg visas genom att ta bort Hide extensions for known file types på alternativet 
Folder i Tools-menyn.) 
 

c) Stäng Anteckningar. ”Klicka upp” Explore. Skapa en mapp med namnet Cslask i 
C:\Temp. Kopiera filen soligt från Din användare till den nya mappen på hårddisken. 
Beskriv kortfattat hur Du gör (det finns flera sätt): 

 
 ______________________________________________________________________ 
 
 ______________________________________________________________________ 
 
 ______________________________________________________________________ 
 
  
d) Skapa med hjälp av Explorer en mapp med namnet Umapp i Cslask. Flytta filen soligt 

från Cslask till Umapp. 
 
e) Radera filen soligt i Umapp. Öppna därefter Recycle bin (papperskorgen) och 

kontrollera om filen finns där. 
 
 Gör den det? ______________________ 
 
f) Ta bort hela mappen Cslask. Töm sedan Recycle bin. 
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Tillbehör 
a) Starta Paint (All Programs/Accessories). Rita någonting liknande detta: 
 Spara filen med namnet bild1 i Slask. 

 
Vilket filtillägg får den? _______________________ 
 
Hur stor blev filen? ___________________________ 

 
 
b) Starta Calculator och räkna ut uppgiften nedan: (Kontrollera svarets rimlighet!) 
 
 23 + 3,6 * 456/12 – 14,5 = 
 
 
 

Sökfunktionen, mm 
a) Gå till Explore. Markera din hemkatalog i den vänstra delen. Gå till menyn File/slask/ 

Search. Skriv soligt i textrutan för filnamn och klicka på Search. I det lilla fönstret 
nedtill skall du nu kunna hitta din fil. För att kontrollera att det är rätt fil, klickar du på 
den med höger musknapp och väljer Open. Kontrollera filen i fönstret som öppnas och 
stäng det. Om du nu skulle vilja öppna filen, är det bara att dubbelklicka på den. En 
annan finess: Om du vill gå till den mapp där filen ligger, väljer du File/ 
Open Containing Folder i sökfönstret. Prova det och stäng därefter alla fönster. 

 
b) Öppna en valfri mapp med många filer. Testa nu funktionerna View/Icons respektive 

Details. Stanna på den sista. Testa också View/Arrange Icons by och prova de alternativ 
som finns där. 

 
c) Skapa genväg till soligt (dokumentet) på skrivbordet genom att "släpa" filen dit med 

höger musknapp nedtryckt. 
 
Testa genvägen. 

 
Ta bort genvägen från skrivbordet (höger musknapp). 
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Word (OH) 
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Word – Sammanfattning 
 

Nytt dokument 
 
Nytt Välj vilken dokumentmall du vill använda med Office-knappen → 

Nytt. Mallen Tomt dokument (filen Normal.dotm) används mest. 
(Då du har skapat en egen mapp för mallar, kan du välja att öppna 
mallar från  
Mina mallar. Det gäller i synnerhet för Tomt dokument som du 
kommer att ha en egen version av.) 
 
Välj Visa → Utskriftslayout. Välj också zoomningsgrad i Visa → 
Zooma. 

 

Marginaler  
  
Inställning Värden för marginaler anges i Sidlayout → Utskriftsformat → 

Marginaler →  
Anpassa marginaler.  

 
 Margialer kan också ställas in m h a musen och 

linjalen. En dubbelriktad pil ska i så fall visa sig. 
 

Sidhuvud/sidfot 
 
Infoga  Sidhuvud infogas med Infoga → Sidhuvud/sidfot → Sidhuvud 

och sidfot med Infoga → Sidhuvud/sidfot → Sidfot. 
 
Fält  Man bl.a. lägga in sidnr, datum och tid. Se dialogrutan Text på 
 Infoga-fliken. Även andra typer av fält fungerar, exempelvis kan 

dokumentets namn läggas in. Se alternativet Fält på Snabbdelar.  
 

Avvikande sidor Om olika sidhuvuden önskas, läggs en löpande avsnittsbrytning in. 
Om endast första sidan ska avvika kan man använda Infoga → 
Försättsblad. 
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Kantlinjer 
 
Infoga I Start → Stycke → Kantlinje kan kantlinjer runt markerade 

stycken läggas in. För linjer under eller över rader räcker det att 
ställa markören på raden.  

 

Indrag 
 
Ändra Indrag kan ändras med Start → Stycke → Minska indrag 

respektive Start → Stycke → Öka indrag.  
 
Linjalen Det går också att använda linjalen enligt följande:  
 
 
 
 
 
 
 
 

Aktivera linjal med Visa → Linjal. 
 

Tabulatorn 
 
Inställning Önskade tabblägen anges/ändras med cm-mått. Inställningarna 

gäller markerade rader och/eller följande rader. Observera att de 
förinställda tabblägena som ligger till vänster om nya lägen, 
automatiskt raderas.  

  
 Inställningar görs med mus och linjalen. Välj först tabbtyp i rutan 

längst till vänster: 
   
  Vänstertabb 
  Högertabb 
  Centrerad tabb 
  Decimaltabb 
  Fälttabb 
 
 Därefter klickas tabblägena dit efter behag. Gamla lägen kan tas 

bort med musen genom att dra dem nedåt och släppa. 
 
Finjustering Finjustering kan göras i den dialogruta som visas då man dubbel-

klickar på en tabb som finns utplacerad på linjalen. 
 

Dra här för första 
radens indrag 

Dra här för  
vänster indrag 

Dra här för  
hängande indrag 
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Spara 
 
Spara som... Använd Office-knappen → Spara som för att välja enhet och 

katalog samt filformat (Word-dokument). Ange namn på 
dokumentet (använd inte / i namnet). Tillägget .docx fås 
automatiskt.  

 
Spara Efter att dokumentet en gång är sparat, räcker det 

fortsättningsvis att trycka på diskettknappen. Spara ofta.  
 

Tabellfunktionen 
 
Infoga Infoga ny tabell med Infoga → Tabeller → Tabell. OBS! Lämna 

alltid minst en tomrad ovanför tabellen för att senare kunna infoga 
eventuell rubrik. Välj antal rader och kolumner i dialogrutan 
(ytterligare rader och kolumner kan infogas i efterhand). 

 
 Celler kan sammanfogas horisontellt, exempelvis då man vill ha  
 centrerad rubrik. (Celler kan också sammanfogas kolumnvis.) 

Sammanfogningen görs genom att markera celler, höger-klicka på 
markeringen och välja Sammanfoga celler. (Du kan också 
markera tabellen och välja Tabellverktyg, Layout → Koppla →  
Sammanfoga celler.) 

 
 Storleken på celler, rader eller kolumner kan anges. Detta görs 

enkelt med musen direkt i tabellen (drag och släpp).  
 
 Förflyttning mellan cellerna sker med mus eller tabbtangenten. Om 

du står i sista cellen, skapas en ny rad med tabbtangenten. 
Tabblägen går att infoga i cellerna. Förflyttning sker då med  
Ctrl + Tab. 

 
Stödlinjer Stödlinjer underlättar om tabellinjer inte används. Genom att 

markera tabellen visas dialogrutan Tabellverktyg. Välj sedan 
Tabellverktyg → Tabellformat → Kantlinjer → Visa 
stödlinjer. Stödlinjerna syns inte vid utskriften. 

  
 
Teckenvisning Med teckenvisningsknappen visas diverse formattecken 

såsom mellanslag, tabbförflyttningar, styckeslut, etc. 
 Knappen finns i dialogrutan Stycke på Start-fliken. 
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Bilder och figurer 
 
Dialogrutan I denna dialogruta kan du välja ut och förhandsgranska en bild ur  
Illustrationer Clip Art-galleriet.  
på Infoga-fliken 

Välj Bild om vill infoga  
en bild som finns sparad  
på exempelvis  
hårddisken.  
 
Figurer, SmartArt och Diagram består av färdiga ritobjekt som 
kan ändras. 

 
 Om du vill att texten ska ”flyta runt” en bild, ska du först markera 

den och därefter gå till Bildverktyg, Format → Ordna → 
Figursättning. Välj exempelvis Rektangulärt.  

 
 I Figursättning kan du också välja Fler layoutalternativ för att på 

fliken Bildläge kunna bocka för Lås fästpunkten (använd inte 
Flytta objekt med texten). Det brukar innebära att bilden inte 
uppför sig alltför vildsint. 

 
 Om du vill lägga en bild i en tabell, måste du avmarkera 

inställningen Layout i tabellcell. Även detta görs i Figursättning.  
 

Ritverktyg 
 
Figurer  Infoga → Illustrationer → Figurer ger vektorgrafik med färdiga 

objekt vars egenskaper kan ändras. Det används för enklare bilder. 
Flera objekt kan grupperas till ett objekt. Objekten kan kopieras 
och speglas och vridas samt färgläggas efter behag. 
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Dokumentmallar 
 
Nytt Ny dokumentmall skapas genom att välj Skapa Mall i Office-

knappen → Nytt. I mallen kan du skriva in standardtexter, lägga 
in logotyper, etc samt ställa in format. 

 
 Mallen sparas sedan i lämplig mapp på din ”användare”. Den 

kommer sedan med på dokumentmallslistan då du startar ett nytt 
dokument (Office-knappen → Nytt). 

 
 Dokumentmallen får formatet .dotx eller .dotm (makroaktiverad) 

och är skyddad för överskrivning så länge man går via Office-
knappen → Nytt. (Använd makroaktiverad dokumentmall i 
datasalarna.) 

 
Öppna Från Office-knappen → Öppna kan du öppna en dokumentmall 

för att kunna ändra i den. I det här läget skrivs alltså den gamla 
mallen över! 

 
 Dokumentmallarna kan sedan kompletteras med formatmallar, se 

nästa avsnitt! 
 

Formatmallar 
 
Dialogrutan Format Formatmallar innehåller förinställda formateringar för exempelvis  
på Start-fliken. teckensnitt, fetstil, radhöjd, etc. Det finns två typer: styckemallar 

och teckenmallar. Som standard visas mallarna Normal, Rubrik1, 
Rubrik2 och Rubrik3. Många fler finns. 

 
 I dialogrutan kan du dels skapa nya formatmallar, dels ändra i de 

befintliga.  
 
Formathämtning Om du vill formatera ett stycke likadant som ett annat, börjar du 

med att markera det formaterade stycket (eller 
ordet). Klicka sedan på formathämtningsknappen 
(Start → Urklipp → Hämta format), placera 
markören på det nya stycket och klicka. 
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Långa dokument 
 
Sidhuvud/sidfot När du skriver långa dokument (många sidor) bör du i sidhuvudet 

eller -foten ange dokumentnamn, sidnummer och eventuellt antalet 
sidor. Dessa uppgifter och liknande finns att hämta i dialogrutorna 
Sidhuvud/sidfot och Text på Infoga-fliken. 

  
Sidbrytning I långa dokument är det också lämpligt att lägga in sidbrytningar 

med jämna mellanrum samt lämna några tomrader under 
brytningen. (Sidbrytning görs i dialogrutan Sidor på Infoga-
fliken.) 
 

Nytt sidhuvud eller Om sidhuvudet eller sidfoten ska byta utseende, sätter man in en  
ny sidfot avsnittsbrytning. En sådan läggs in med Sidlayout → 

Utskriftsformat → Brytningar → Avsnittsbrytningar → Nästa 
sida. Därefter kan det nya sidhuvudet eller sidfoten designas, 
exempelvis med en ny serie sidnummer, kanske med helt ny 
teckenuppsättning. (Man kan tänka sig ny sidnummer serie med 
alfanumeriska tecken eller romerska nummer istället för arabiska 
siffror.) 

 
Rubriker Använd förformaterade rubriknivåer, exempelvis Rubrik1, 

Rubrik2 och Rubrik3. De förinställda formateringarna kan 
naturligtvis ändras. (Formatmallar finns i dialogrutan Format på 
Start-fliken.) 

 
Punkter och numrering Rubriknumrering kan infogas för hela dokumentet på en gång 

under  
 förutsättning att rubriknivåerna har använts på rätt sätt. Välj 

Flernivålista. Dessa funktioner finns att hämta i dialogrutan 
Stycke på Start-fliken. 

 
Förteckningar  Under fliken Referenser kan olika innehållsförteckningar, fotnoter, 

källhänvisningar, litteraturförteckningar, figurförteckningar, index 
och citatförteckningar väljas. (Ställ först markören där du vill ha en 
förteckning.) 
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WordArt  

Med WordArt kan text formateras på ett mer omväxlande sätt än i ett 
ordbehandlingsprogram. Observera att denna funktion bör användas med omdöme. Denna 
funktion finns att hämta i dialogrutan Text på Infoga-fliken. 
 
Exempel från WordArt: 
 
 
 
 
 
 
 
 

 

Equation Editor 
 
Starta med Infoga → Text → Objekt → Microsoft Equation 3.0. (Givetvis kan Ekvation i 
dialogrutan Symboler på Infoga-fliken användas, men i datasalarna på Teknik är inte 
Ekvation aktiverad.) 
 
Med hjälp av Equation Editor kan du skapa sammansatta formler genom att välja symboler 
från ett verktygsfält och skriva in de variabler och tal som ska ingå. Du behöver inte tänka på 
de enskilda elementens storlek eftersom teckenstorlek, avstånd och formatering sker 
automatiskt efter de konventioner som gäller för formler i matematiska sammanhang. Du kan 
justera formateringen och ändra formatmallarna om du inte är nöjd med dem. 
 
Exempel från Equation Editor: 
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Diagram 
 
Diagram finns i dialogrutan Illustrationer på Infoga-sidan. Det hämtar data från ett 
arbetsblad med tabeller. Du använder Diagram för att visa numeriska data i grafisk form, 
vilket kan göra dem enklare och tydligare att läsa. Vid presentationer och analyser kan det 
vara bra att kunna åskådliggöra data grafiskt. 
 
Ett diagram som du skapar infogas som ett 
inbäddat objekt i rapporten, presentationen, 
nyhetsbrevet eller något annat dokument i 
programmet. Precis som med andra inbäddade 
objekt kan du kopiera, ta bort eller ändra storlek 
på diagrammet med kommandona i 
huvudprogrammet. Ett betydligt kraftfullare 
program för diagram finns i Excel. 

 

Kopplade dokument 
 
Med kopplade dokument kan man skriva exempelvis adressetiketter och massbrev. Förut-
sättningen är någon form av databas, där adressuppgifterna lagras. Enklast är att göra en 
sådan databas i Word med hjälp av tabellfunktionen. 
 
Se dialogrutorna Skapa och Starta koppling av dokument på Utskick-fliken. 
 

Makron 
 
Makron används för att automatisera åtgärder som man utför ofta. Man kan exempelvis göra 
ett makro som gör markerad text till nedsänkt. Makrot går att koppla till antingen en knapp, 
en meny eller till en tangentkombination. Makron hanteras i dialogrutan Makron på Visa-
fliken. (Hantering av makron kan också göras på Utvecklare-fliken. Fliken aktiveras på 
Office-knappen → Word-alternativ → Vanliga alternativ.) 
 
Inspelning Det enklaste sättet att göra ett makro är att spela in det, vilket 

innebär att de åtgärder som utförs med mus och tangentbord sparas 
och kan återupprepas med ett enda knapptryck. 

  
Spela in makro Ange ett namn för makrot i rutan och om makrot ska kopplas till 
Stoppa inspelning knapp eller tangentbord. (Det går att köra makron utan kopplingar 

till knapp eller tangentbord.) Eventuellt kan du också ange vad 
makrot ska vara tillgängligt för. Klicka på OK för att spela in. 
Glöm inte att stoppa efter önskad inspelning. 
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Visa makron I Visa makron kan du hantera färdiga makron. Du kan köra 
makron, se hur makron ”ser ut” och ta bort makron.  
 
Man kan visas den programkod i VBA, som styr makrot. Det går 
att ändra i koden om man vet hur man gör. Det går naturligtvis 
också att skriva all kod direkt utan inspelning, men då ska man vara 
en riktig hävert på VBA. 

 
Makrot  Ett användbart makro är AccepteraMarkeradeÄndringar som 
AccepteraMarkeradeÄndringar  inte innehåller någonting. Det kan användas för att "markera plats" 

för text. Detta makro kopplas till fältkoden Macrobutton. Du 
infogar detta med Snabbdelar i dialogrutan Text på Infoga-fliken.  
 
Välj Snabbdelar → Fält → [Alla] → MacroButton → 
AccepteraMarkeradeÄndringar och skriv en instruktion (Visa 
text), exempelvis Skriv ditt namn här.  
 
När du stänger dialogrutan kommer makrotexten att placeras vid 
markören. Om du klickar på texten kan du skriva in ditt namn. 
Makrot kan återställas med Ångra inmatning. 
 
Ångra/Gör om inmatning:  

 

Formulär 
 
Om man vill skapa en blankett för exempelvis faxmeddelanden, kursanmälan, etc. kan man 
använda formulärfältsfunktionen. Man gör först en blankett, lämpligtvis med hjälp av 
tabellfunktion och placerar därefter formulärfält där användaren ska fylla i egna uppgifter. 
Mallen går sedan att låsa så att användaren endast kan fylla i efterfrågade uppgifter. 
 
Utvecklare-fliken Fliken aktiveras på Office-knappen → Word-alternativ →  

Vanliga alternativ. Den behövs för formulärhantering som finns i 
dialogrutan Kontroller.  

 
 
Fält och rutor   
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I denna Kontroller-dialogrutan rekommenderas kontrollerna som 
finns i Tidigare verktyg → Formulär från tidigare versioner. 

 
Från vänster visas textfält, kryssruta, kombinationsruta, infoga 
vågrät ram, visa fältskuggning och återställ formulärfält. Det är de 
tre första från vänster som kommer att användas under Word-
övningarna. Respektive egenskap får man upp genom att höger-
klicka på fälten/rutorna. Det gäller exempelvis följande: 

 
Textfält - Du kan ange texttyp, maximalt antal tecken, standardtext 
(visas som förslag i blanketten) och format. 

 
Kryssruta - Du kan ange storlek och eventuellt standardvärde. 

 
Kombinationsruta - Du kan ange vilka element som ska vara med 
i listan och i vilken ordning de ska visas. 

 
Design Vanligtvis ska Designläge startas innan arbetet med kontroller 

påbörjas. För Formulär från tidigare versioner saknar detta 
betydelse. Arbetsgången blir följande: 

  
Om så önskas, aktivera Designläge. 
Lägg ut önskade kontroller och om så behövs, ledande text. 
Varje kontroll ska ställs in, dvs. höger-klicka och välj Egenskaper. 
Skydda dokument → Begränsa formatering och redigering. 
Välj Formateringsbegränsningar och Redigeringsbegräsningar.  
Inaktivera Designläge och Starta tvingande skydd. 
Skriv in önskat lösenord. 
Testa formuläret. 
Spara som mall med Makroaktiverad Word-mall  (*.dotm). 
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Internet Explorer och Word 
 
När man hittat något intressant på en webbsida och vill få ner det på papper, kan man göra på 
olika sätt: 
 
• Utskrift kan göras direkt i IE. Formateringen blir då exakt som på bildskärmen. 
• Genom att använda Kopiera, Klistra in - funktionen. Texten kan då klistras in i ett 

Worddokument och blir då ofta oformaterad med styckeslut på varje rad. 
• Genom att spara webbsidan som text och sedan importera den till en ordbehandlare. 
• Bilder sparas eller kopieras separat. 
 
 
Utskrift direkt i  Välj Print Preview (eller Print direkt), kontrollera utskriften,  
IE speciellt antalet sidor, och klicka på OK. 

 
Kopiera, Klistra in Markera på webbsidan med hjälp av musen den text som du vill 

kopiera. Välj kopiera (markera text, höger-klicka och Copy) och gå 
till Word. Placera markören där du vill ha texten och välj Klistra 
in (dialogrutan Urklipp på Start-fliken). Klicka på Visa alla 
(dialogrutan Stycke på Start-fliken) för att se alla mellanslag, 
tabbar och styckeslut som texten brukar vara nedlusad med. För att 
få texten snygg krävs ofta en hel del arbete. Man kan ha god hjälp 
av funktionen Sök (dialogrutan Redigering på Start-fliken). 

 
Spara webbsidan Välj Page → Save As i IE. Ändra filformatet till Text File och 

filnamnstillägget från .htm till .txt samt välj lämplig katalog. 
Öppna dokumentet i Word. Ändra i dialogrutan filformatet till Alla 
filer. För textkodning rekommenderas Windows (standard).  
 

Bilder Placera muspekaren på bilden i IE och klicka på höger musknapp. 
Då visas en meny där du kan spara bilden i aktuellt format (oftast 
.gif eller .jpg), eller kopiera den. Bilden kan sedan hämtas in direkt 
till Word, alternativt klistras in. 
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Rapportskrivning (OH) 
 
 

Högskolan i Örebro/Teknik

     Just jag!   Skriva??

Ja.Vem annars!!!
Du kan ämnet!
Du tänker logiskt!
Du känner läsaren!
Du kan fackspråket!

 
Högskolan i Örebro/Teknik

  Typ av dokumentation

Användningsområden
Marknadsföring
Användarhandbok
Projektdokumentation

Olika syfte, olika målgrupper, olika utformning

 

Högskolan i Örebro/Teknik

 Block- och modulmetoden

1. Sammanfattning 2. Funktion 3. Service

 Utveckling av systemet X
1. Sammanfattning

2. Funktion
3. Service

Fyll på efterhand!

 
Högskolan i Örebro/Teknik

  Logisk tankekedja

Se till att det finns en
”röd tråd”.
Förutse läsarens frågor.

 

Högskolan i Örebro/Teknik

   Säljbrevstrappan

   Aktivera
   Övertyga

  Intressera

  Fördelar       Bevis Erbjudande

 
Högskolan i Örebro/Teknik

    Val av språk

    EN BALANSGÅNG!
Lagom svåra meningar
Lagom svåra ord
Lagom informationstäthet
Rätt abstraktionsnivå
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Högskolan i Örebro/Teknik

   Abstraktionsstegen

  ABSTRAKT
Komponent
Integrerad krets
CMOS-krets
MACH110

  KONKRET

 
Högskolan i Örebro/Teknik

   Faktatät text

Cylinderröret av rostfritt stål
är inpressat och låst i de båda
runda plastgavlarna, som har
radiellt placerade anslutnings-
portar riktade åt samma håll.

 

Högskolan i Örebro/Teknik

  Orsakskedja

   Enligt skolresemodellen:
   På grund av överhettning hade några

komponenter i servern gått sönder. Hela
datorsystemet stod därför stilla i 10
timmar. Detta medförde ett produktions-
bortfall på 1000 enheter under maj månad.

 
Högskolan i Örebro/Teknik

  Orsakskedja

   Enligt löpsedelstekniken:
   Vi fick ett produktionsbortfall på 1000

enheter under maj månad. Hela
datorsystemet stod stilla i 10 timmar
därför att några komponenter i servern gått
sönder. Orsaken till detta var överhettning.

 

Högskolan i Örebro/Teknik

  Aktiv och passiv text

Aktiv text säger mer!
    När operatören startar systemet ska det automatiskt

genomlöpa en testsekvens för att han ska kunna
kontrollera funktionen.

Passiv och opersonlig text:
    När systemet startas ska en testsekvens genomlöpas

för att funktionen ska kunna kontrolleras.

 
Högskolan i Örebro/Teknik

  Inskott

Bättre:
Du kan starta programmet från början utan att först
nollställa alla register och räknare.

Exempel:
Du kan, utan att först nollställa alla register och
räknare, starta programmet från början.

 



Datoranvändning Rapportskrivning SBN 
 

 34

Högskolan i Örebro/Teknik

   Vänstertyngd och högertyngd

Det blir lättare med högertyngd!
    Tillverkningen av produkten bör upphöra eftersom den inte är

anpassad till modern produktionsteknik och det skulle ställa sig
alltför dyrbart att göra nödvändiga modifieringar.

Vänstertunga meningar är svårlästa!
    Eftersom produkten inte är anpassad till modern

produktionsteknik, och det skulle ställa sig alltför dyrbart att
göra nödvändiga modifieringar, bör tillverkningen upphöra

 
Högskolan i Örebro/Teknik

  Det tredje språket

 

Högskolan i Örebro/Teknik

Layout-tips

Maximalt tre rubriknivåer
Typsnitt

Rubriker - utan serifer, ex Arial
Brödtext - med serifer, ex Times New Roman

Indrag
Första stycket  - inget indrag
Övriga stycken - ”fyrkant” indrag

 
Högskolan i Örebro/Teknik

   Fas 2  -  Finslipning

Strukturering
Syfte och målgrupp
Löpande text
Underrubriker
Logisk tankekedja
Ordval och stavning
Språkliga fel
Låt andra läsa !

 

Högskolan i Örebro/Teknik

Ytterligare tips

Word:
Använd formatmallar för rubriker
Använd automatisk rubriknumrering
Använd automatisk innehållsförteckning

Ännu ytterligare tips
http://www.bibl.liu.se/teknologibiblioteken/teknisk_
vetenskaplig_information/tgv.htm

 
Högskolan i Örebro/Teknik

  Användarhandledningar

Utgå från läsarens situation
Var entydig
Gärna numrerade punkter
Orienterande inledning
Läsanvisning
Spar tid åt läsaren

 

 



 
 
 
 
 
 

RAPPORTSKRIVNING 
 
 
 
 

En liten introduktion till den tekniska dokumentationens svåra konst. 
 

 
 
 
Sammanfattning 

Det är viktigt att först bestämma för vem du skriver, så att informationen hamnar på 
rätt nivå. Presentera innehållet med löpsedelsteknik, det vill säga med det viktigaste 
först.  
 
Sammanställ informationen i block och moduler för att du lättare skall komma igång. 
Mindmapping ger en bra överblick. 
 
En rapport kan delas in i tre huvuddelar: 
• Titelsida, innehållsförteckning, sammanfattning, förord 
• Huvuddel 
• Referenser, bilagor 
 
Språket i en rapport skall på ett ledigt och naturligt sätt bära fram informationen. 
Skriv i aktiv form, undvik substantiverade verb, inskott och "svengelska". 
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1 INLEDNING 
 

1.1 Varför just jag? 
Du kan ämnet och som blivande ingenjör tänker du troligen logiskt. 
 

1.2 Bestäm målgruppen 
Tänk på vem som skall läsa din rapport. Målgruppen avgör nivå och innehåll i 
rapporten. 
 

1.3 Val av språk 
∗ Lagom långa meningar 

∗ Lagom svåra ord 

∗ Lagom informationstäthet (En till två fakta per mening) 

∗ Rätt abstraktionsnivå 

∗ Skriv entydigt 

 

1.4 Löpsedelsteknik 
Det viktigaste först. Detta gäller hela framställningen, varje avsnitt och varje mening 
 

1.5 Logisk tankekedja 
Läsaren ska enkelt kunna följa din tanke i texten. Försök att förutse läsarens frågor  
 

1.6 Säljbrevstrappan 
 

 
 
 

 
         Aktivera 
       Övertyga 
   Intressera 
   
   Fördelar        Bevis  Erbjudande 
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1.7 Informationsekonomi 
 
Spara tid åt läsaren. Tänk på att om många skall läsa rapporten blir den sammanlagda 
lästiden avsevärd. 
 

2 NÅGRA TIPS FÖR ATT KOMMA IGÅNG 
 

2.1 Block- och modulmetoden 
 
Skriv arbetsrubriker. Samla material för varje rubrik på särskilt papper. Vänta gärna 
med inledningen. Tänk på att försöka åstadkomma en logisk tankekedja. 
 
Sammanställ materialet och finslipa formuleringar och rubriker 
 

2.2 Mindmapping 
 

∗ Bra för att få en inledande överblick 

∗ Stimulerar associationsförmågan 

 

3 DISPOSITION AV EN TEKNISK RAPPORT 
 

3.1 Förslag till rapportavsnitt 
 
Omslag - Titelsida. 

∗ Titel (ibland även på engelska) 

∗ Författare (i bokstavsordning) 

∗ Företag - Organisation, numrering 

∗ Ort och datum 

 
Sammanfattning 
 
Innehållsförteckning 
 
Förord 

∗ Tack till dem som hjälpt till under arbetets gång 
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Rapportens huvuddel. 
∗ Inledning, bakgrund, förutsättningar 

∗ Analys, beskrivning, utförande 

∗ Slutsatser, resultat, rekommendationer 

 
Referenser 

∗ Litteratur 

∗ Artiklar 

∗ Personer 

 
Bilagor. (numreras löpande) 

∗ Mätresultat, tabeller mm. 

 
 

4 NÅGRA TIPS OM LAYOUT 
 
Använd inte mer än tre rubriknivåer. 
 
Ex:    1  KAPITELRUBRIK 
 1.1  Avsnittsrubrik 
 1.1.1  Underrubrik 
 
Tänk på att ord som är kursiverade, understrukna eller skrivna med stora bokstäver 
stoppar upp läsandet. Placera bilder i direkt anslutning till den text som hänvisar till 
bilderna. Risken att ingen läser din text är uppenbar om sidan består ev en kompakt 
textmassa utan rubriker, luft och figurer. Undvik avstavning om du inte tänker 
använda marginaljustering. 
 
 

5 SPRÅKET I EN TEKNISK RAPPORT 
 

5.1 Substantivsjukan. 
Substantivsjukan innebär att du gör om verb till substantiv 
genom att lägga till -ande, -ing, -else. 
 
 Ex:  Utredande, förändringen, skapelse 
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 Ex:  Förändringen av rutinerna genomfördes av Andreas. 
        Bättre: Andreas förändrade rutinerna. 
 
 Ex:  Billarmet konstruerades av Mikael. 
         Bättre: Mikael konstruerade billarmet. 
 

5.2 Inskott ger krångliga meningar. 
 
 Ex:  Du kan, utan att först ställa in oscilloskopet, koppla in mätprobarna. 

Bättre: Du kan koppla in mätprobarna utan att först ställa in 
oscilloskopet. 

 

5.3 Kom snabbt till saken. 
∗ Använd löpsedelsteknik 

∗ Det viktigaste först i varje mening 

 
Tänk på att många tekniska fackord finns på svenska. Undvik svengelska! Förklara 
förkortningar inom parentes. 
 
 Ex: CPU (Central Processing Unit) 
 
Skriv förkortningar i klartext. 
 
 Ex: from = från och med 
 
 

6 RESULTAT OCH SLUTSATSER 
 
Tänk på att det är enbart genom träning som du kan bli en bättre rapportskrivare. 
Repetera huvudpunkterna i detta häfte och tillämpa dem när du skriver. Ta några 
punkter i taget. Tänk på hur andra skriver. Det finns både goda förebilder och 
avskräckande exempel. 
 
 

7 REFERENSER 
 
Erik Walla: Att skriva tekniska rapporter 
 Dala Information AB 
 Borlänge 
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Övningar i Word 

Inställningar innan övningarna 
 
A. Visa alla filändelser och skapa mappar (kataloger) för dina Word-dokument 
 
1. Gå till Start → My Documents 
2. Ta bort bocken för alternativet   □ Hide extensions of known file types 

som finns på Tools → Folder Options… → View. 
3. Ta fram din användarmapp (hemkatalog) på M:\Pcsa 
4. Välj File → New → Folder 
5. Ge den nya mappen namnet Worddokument 
 
Detta ger en mapp med sökvägen M:\Pcsa\Worddokument. 
 
Skapa även en mapp med namnet Mallar  i M:\Pcsa. 
 
 
B. Öppna programmet Word med och gör inställningar i ett tomt dokument 
 
1. Följ Word (OH) - Sökvägar för att ändra sökvägarna till dokument och mallar. Använd 

de nya mapparna, enligt inställning A. 
 

2. Följ Word (OH) - Autokorrigering  för att ändra… 
Ersättning vid inskrivning av text :  använd valfria 
Använd vid inskrivning av text: ta bort alla 
Utför automatiskt vid inskrivning av text :  ta bort alla 
 

3. Följ MS Word, sammanfattning – Formulär för att visa Utvecklare-fliken. 
 

4. Spara för säkerhets skull ditt dokument i avsedd mapp. Gör det ofta i fortsättningen för att 
spara dina inställningar. 
 
Ställ in formatmallarna Rubrik 1 , Rubrik 2 , Rubrik 3  och Normal. (Det är viktigt att 
Normal ställs in sist eftersom sist ändrad formatmall kommer att vara aktiv i nya 
dokument.) Höger-klicka på respektive formatmall för att ändra. 
 
Rubrik 1:  Arial, 14 punkter, fet stil och automatisk (svart färg) 
Rubrik 2:  Arial, 12 punkter, fet stil och automatisk (svart färg) 
Rubrik 3:  Times New Roman, 12 punkter, fet stil och automatisk (svart färg) 
 

 Ställ in stycke för Rubrik 1, Rubrik 2 och Rubrik 3 med lika avstånd. 
 Före:  12 pt 
 Efter:  3 pt 
 Radavstånd: Enkelt 
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Normal:  Times New Roman och 12 punkter och automatisk (svart färg) 
 

Ställ in stycke för Normal. 
Före och efter:  0 pt 
Radavstånd: Enkelt 
 

5. Ställ in vänster och höger marginal till 3 cm i  
Sidlayout → Utskriftsformat → Marginaler → Anpassade marginaler. 

 
6. Efter steg 5 behöver sidhuvudet och sidfoten justeras med avseende på tabben vid den 

högra marginalen. Dra det högerställda tabbstoppet till kanten för den högra marginalen i 
både sidhuvudet och sidfoten.  
 

7. Spara som Normal2.dotm med filformatet makroaktiverad Word-mall i M:\Pcsa\Mallar . 
 

8. Stäng Word. 
 

9. Ta bort Normal.dotm. 
 

10. Byt namn på Normal2.dotm till Normal.dotm. 
 

11. Öppna Word på nytt. 
 
Kontrollera att den nuvarande mallen har dina inställningar. Vid fel, korrigera och spara 
en ny mall. 
 
(Om du väljer Office-knappen → Nytt, så motsvarar Tomt dokument i Mina mallar  
din Normal.dotm.) 

 
 
Tänk dig att du vid nästa övningstillfälle öppnar Word och upptäcker att mallen inte är din 
speciellt inställda Normal.dotm. Du vet att din mall finns men den blir ända inte öppnad. Vad 
ska du göra då? 
 
Svar:        
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Övning 1  
 
 
Första övningen är till för att testa grundläggande funktioner i Word, speciellt marginaler, 
indrag och tabulering. Skriv av texten Skrivövning som återfinns på nästa sida. Skriv av 
texten i sin helhet och följ anvisningarna i texten.  
 
Lägg också till ett sidhuvud som i förlagan, men ersätt Förnamn Efternamn med ditt namn. 
Glöm inte bort att infoga en kantlinje (under) i sidhuvudet.  
 
Observera att de angivna inställningarna för marginalen inte stämmer med förlagan, eftersom 
den ingår i ett större dokument. Därför kommer förmodligen inte radbrytningarna att stämma. 
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Skrivövning  
 
Skriv av denna text. Rubriken ska ha typsnittet Arial, 16 pktr, och vara centrerad. 
Sidomarginalerna ställs in på 3 cm och övre respektive undre marginal ska vara 2,5 cm. 
Texten ska skrivas löpande, använd endast Enter-tangenten vid styckeslut. 
 

Det här stycket ska ha ett indrag på 2 cm från marginalen. Skriv färdigt stycket 
först, ställ markören i stycket och gör indraget genom att ta tag i den lilla 
fyrkanten uppe vid linjalen. 

 
 
Marginalrubrik åstadkommer man genom att dra den undre triangeln vid linjalen åt 

höger (4 cm). Därefter skriver man rubriken, trycker på 
Tabbtangenten och fortsätter skriva. Då erhålls automatiskt rak 
vänsterkant vid 4 cm-indraget. Detta kallas hängande indrag. 

 
Dra tillbaks triangeln! Hoppa ner till nästa rad och ställ in tabbarna: 
 Vänstertabb, 2 cm Centrerad tabb, 8 cm Högertabb, 14 cm 
 Test Test Test 
 
Lägg märke till att tabbinställningarna följer med på nästa rad, dvs även den här. Ta bort en 
tabb genom att ”greppa” den med muspekaren och sedan dra bort den från linjalen. 
 
Vi avslutar med ett stycke som ska marginaljusteras. För 
att det inte ska bli för glest bör man använda 
avstavningsfunktionen först. Markera hela stycket och gå 
till Sidlayout → Utskriftsformat → Avstavning. Välj 
Automatisk avstavning och avstavningszonen 0,5 cm. 
Klicka på OK och därefter på marginaljustering (Start → 
Stycke → Marginaljustera ). Infoga en bild och placera 
den ungefär på detta sätt. Sedan bör stycket se ut ungefär 
så här. 
 
 
 
Så här kan tabellfunktionen utnyttjas: (OBS! Kantlinjerna är här inlagda så att du ska se hur 
tabellen är disponerad.) 
 

 

 
 

Dispositionsexempel 

”Det var en afton i början av 
maj, den lilla trädgården ...” 

Detta är ett citat från den berömda 
romanen Röda rummet, som var 
Strindbergs debutroman. (Denna text är 
avstavad och marginaljusterad.) 
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Övning 2 
 
Denna övning ger dig grunderna för att arbeta med samlingsdokument, utskriftslayout  och 
disposition. Detta är användbart vid sammanställning av större rapporter. Genom att göra 
grundarbetet i mindre delar blir arbetet lättare och eventuella missgrepp blir begränsade till 
den del du för tillfället arbetar med. Delarna sätts samman till ett samlingsdokument. Därefter 
är det lämpligt att lägga in rubriknivåer, skapa innehållsförteckning och finjustera i 
sidlayoutläget. 
 
Ditt samlingsdokument ska sättas samman av följande: huvud.docm, und1.docm, 
und2.docm och und3.docm. 
 
Målet är att skapa ett dokument med utförande enligt förlagan RAPPORTÖVNING  
(återfinns direkt efter uppgiftsbeskrivningen). Dokumentet är tänkt som en Word-övning och 
som ett exempel på hur en enkel rapport kan se ut. 
 
Använd rättstavningsfunktionen och utnyttja hjälpfu nktionerna vid problem. 
 
Testa dina idéer! Det är lätt att ångra. Spara med jämna mellanrum för att inte förlora alltför 
mycket tid och arbete om något går fel.  
 

Använd Visa alla-knappen ( ) för att se mellanrum (space), styckeslut, avsnittsslut och 
sidbrytningar mm. Denna information är användbar för att förstå vad som händer vid en 
förändring i en layout. 
 

Uppgifter 
 
1. Använd visningsläget utskriftslayout . Börja med att skriva in förlagans 

Sammanfattning. Skriv utan någon som helst formatering , dvs endast text och 
radbrytningar. Hoppa över innehållsförteckningen. Skriv allt utan indrag och som 
sammanhållna stycken. Blivande punktlistor och rubriker läggs på egna rader. Skriv all 
text med formatmallen Normal och sätt inga nummer framför rubrikerna . Spara 
dokumentet, exempelvis med namnet huvud.docm. Det är viktigt att dokumenten i 
denna övning sparas på formatet Makroaktiverat Word-dokument  (*.docm) . I annat 
fall kan det bli problem med exempelvis bilden som ska ritas. 

 
2. Gör på samma sätt med förlagans första kapitel. Spara med namnet und1.docm (utan 

bild). 
 
3. Gör på samma sätt med förlagans andra kapitel (und2.docm) och tredje kapitel 

(und3.docm).  
 
4. Stäng samtliga dokument för att sedan öppna huvud.docm och övergå till visningsläget 

Disposition. 
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5. Klicka på Visa dokument. Hämta in und1.docm, und2.docm respektive und3.docm 
så att texterna hamnar efter varandra i rätt ordning, dvs se till att markören står sist i 
dokumentet innan varje hämtning.  Använd följande knapp:  
  
Om man i ett nätverk är flera personer som arbetar med samma dokument, kan man i 
det här läget öppna och arbeta med var sitt underdokument. När man sedan stänger (och 
sparar) sitt underdokument, uppdateras det automatiskt i samlingsdokumentet. 
 

6. Vanligtvis går det utmärkt att låta rapporten bestå av enskilda dokument som kopplas 
samman via ett huvuddokument. Men, då avsnittsbrytningar tas bort i kommande steg är 
detta inte att rekommendera. Det fungerade bra i tidigare versioner av Word men med 
versionen i Office 2007 kraschar länkarna. 
 
Ta bort kopplingarna så att texten från und1.docm, und2.docm och und3.docm läggs 
in permanent i huvud.docm. Placera markören i en koppling och klicka på Ta bort 
koppling. Detta måste upprepas för varje koppling. 
 

7. Gå över till visningsläget Utskriftslayout . Dokumentet är nu uppdelat i allt för många 
sidor, beroende på de avsnittsbrytningar som Word lagt in för att skilja 

underdokumenten åt. Dessa syns om du klickar på Visa alla-knappen ( ). Avlägsna 
avsnittsbrytningarna med Delete-tangenten. 

 
 OBS! Infoga först stycketecken (radmellanrum) med Enter-tangenten före varje  

avsnittsbrytning, om ett sådant saknas. Annars raderas också formateringen för 
nästkommande stycke. 

 
8. Lägg in rubriknivåerna 1 och 2 enligt förlagan. 
 
9. Gå över till visningsläget Disposition. Testa med att enbart visa nivå 1 och 2 samt att 

flytta om rubrikerna med hjälp av de gröna knapparna. Gå över till visningsläget  
Utskriftslayout  och se hur förändringarna påverkat ditt dokument. Återgå till  
Disposition och återställ.  

 
10. Skapa rubriknumrering (Start → Stycke → Flernivålista). Se också  

kommentaren i MS Word, sammanfattning – Långa dokument om numrering. 
 

11. Skapa innehållsförteckning (Referenser → Innehållsförteckning →  
Innehållsförteckning). Välj en automatisk innehållsförteckning. Alternativt kan  
Referenser → Innehållsförteckning → Innehållsförteckning →  
Infoga innehållsförteckning användas. Använd i sådant fall formatet Från mall.  
 
Ställ också in de formatmallar (på Start-fliken) som hör till innehållsförtecknings olika 
rubriker. De ska stämma med innehållsförteckningen i förlagan. Vanligtvis kopplas  
rubriker på nivån Rubrik 1  till Innehåll 1 i förteckningen, nivån Rubrik 2  till  
Innehåll 2, osv. I din rapport används två rubriknivåer. Dessa kopplas automatiskt ihop 
med innehållsförteckningens formatmallar. Ställ alltså in nedanstående formatmallar. 
 
Innehåll 1: Times New Roman, 10 punkter, fet stil och versaler. 
Innehåll 2: Times New Roman, 10 punkter, fet stil och kapitäler. 
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12. Skapa punktlistorna, formatera texten, gör de indrag som behövs. Uppdatera eventuellt 
innehållsförteckningen. (Klicka på Uppdatera tabell som finns i den ram som visas då 
markören placeras i innehållsförteckningen.) 

 
13. Skapa sidhuvud och sidfot . De finns på Infoga → Sidhuvud/sidfot. Sidnumrering,  

sidantal, filnamn och aktuellt datum ska infogas (autotext). Använd Infoga → Snabb-
delar → Fält för sidantal och filnamn. (Sidantal hittar du exempelvis som Fält → Do-
kumentinformation → NumPages.)  
 
Kantlinjer erhålls med Kantlinje -knappen i dialogrutan Stycke på Start-fliken. 

 
14. Rita bilden i kapitel 1.3 med hjälp av Infoga → Illustrationer → Figurer. Observera 

speciellt möjligheterna att gruppera, kopiera, vrida och vända på ritelement (objekt).  
 
Gruppering: markera gruppens ritelement med Shift + vänster musknapp och klicka 
sedan på Gruppera i dialogrutan Ordna. 
 
Skriv in text med hjälp av Textrutan  i Figurer. Ta bort textramarna med Linjer  och 
Ingen färg. (Höger-klicka på ramen och välj Formatera textruta.) Välj Fyllning  och 
Ingen färg för att inte dölja bakomliggande ritelement. 
 
När bilden är färdig, då ska ritelementen grupperas och figursättas (höger-klicka och 
välj Formatera objekt). 

 
15. Infoga en valfri bild (Clipart ) till kapitel 3. Anpassa storleken efter förlagan. Höger-

klicka på den och gör Figursättning. Rektangulär brukar fungera bra. (Bilden ska  
placeras innanför dokumentets marginaler.) 
 

16. Kolla sidbrytningen och uppdatera vid behov innehållsförteckningen. 
 
17. Spara övningen (huvud.docm). 
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RAPPORTÖVNING 
 
 
Sammanfattning 

 
Detta dokument är en övning i att skapa dokument med alla de delar som hör till i form av 
rubriknivåer, sidhuvud, sidfot, innehållsförteckning mm. Dispositionsläget används för att 
koppla underdokument till huvuddokument och lägga in rubriker. 
 
 
Innehållsförteckning  
 

1 FÖRDELAR MED ATT ARBETA I DISPOSITIONSLÄGE ...... ........................................................... 1 

1.1 GENERELLA FÖRDELAR  ........................................................................................................................... 1 

1.2 FÖRDELAR I WORD .................................................................................................................................. 2 

1.3 BILDBESKRIVNING AV SAMLINGSDOKUMENT  ......................................................................................... 2 

2 ARBETA I DISPOSITIONSLÄGE ............................................................................................................ 2 

2.1 SAMLINGSDOKUMENT  .............................................................................................................................. 2 

3 SLUTSATSER ............................................................................................................................................. 2 

 

 

 

1 Fördelar med att arbeta i dispositionsläge 
 
• Utvecklar ett systematiskt tänkande 
• Underlättar strukturering av en rapport 
 

1.1 Generella fördelar 
 
• Ger balans mellan dokumentets olika delar 
• Kan användas för olika sorters dokument 
• Ger en genomtänkt struktur 
 
 



Datoranvändning Wordövning 2 2009-11-06 

Rapportövn.doc  2(2)   

 

1.2 Fördelar i Word 
 
• Ger möjlighet till omstrukturering 
• Formatmallar förenklar redigering 
• Dokument kan skrivas ut från dispositionsläge 
• Samlingsdokument hanteras i dispositionsläge  
 

1.3 Bildbeskrivning av samlingsdokument 
 
 
Ett samlingsdokument sätts samman av flera delar, som kan 
bearbetas var för sig och sedan sammanfogas till en enhet med 
gemensam numrering och innehållsförteckning. 
 
 
 
 

2 Arbeta i dispositionsläge 
 
Klicka på knappen dispositionsläge på statusraden. Ett nytt verktygsfält visas med möjlighet 
till att välja rubriknivåer och vad som ska visas. Det underlättar struktureringen och 
överblicken att man kan välja hur mycket som ska visas och i vilken form det ska visas.  
 

2.1 Samlingsdokument 
 
Längst till höger finns en knapp med vilken ett verktygsfält för samlingsdokument visas. 
Samlingsdokument hanteras i dispositionsläget. Dokument kan delas upp i underdokument, 
underdokument kan slås samman och nya dokument kan infogas. Dokument kan låsas så att 
det inte är möjligt att redigera dem av flera personer samtidigt. 
 

3 SLUTSATSER 
 
• Arbetet förenklas och översikten förbättras 
• Dispositionsläge och samlingsdokument spar tid 
 

Dok 1 

Dok 2 
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Övning 3  

Dokumentmallar och formulär 
 

Målet är att ge kunskap om användning och skapande av dokumentmallar och formulär.  
Använd hjälpfunktionerna vid problem. Testa dina idéer.   
 

1. Testa några dokumentmallar genom att välja Office-knappen → Nytt. En del mallar 
innehåller text, grafik och särskilda dokumentformateringar medan andra är tomma.  
Observera att även utskriftsformatet är kopplat till dokumentmallen. 

2. Skapa ett allmänt försättsblad med universitetets och institutionens namn, rubrik, kort 
sammanfattning, kurs, datum och namn. Förlagan FÖRSÄTTSBLAD  finns efter direkt 
efter uppgiftsbeskrivningen. Den visas både med normal visning och med fältkoder. 
 
Under dina studier vid Teknik kan du använda mallen för att exempelvis skapa försätts-
blad i labrapporter. Tänk alltså på att hålla mallen allmän så att du med få ändringar kan 
uppdatera den. Låt t ex datum skapas automatiskt och använd MacroButton  → Accep-
teraMarkeradeÄndringar . (Se Word, sammanfattning – Makron  i detta häfte.)  
 
Spara mallen i filformatet Makroaktiverad Word-mall  (*.dotm)  i mappen Mallar . 
Denna mapp finns sedan tidigare i din användarmapp (hemkatalog). 

3. Ett formulär används på samma sätt som en dokumentmall, men formuläret är låst på så 
sätt att text och siffror endast kan skrivas in på förutbestämda platser. Fördelen är att 
ingen av misstag kan göra ändringar i formulärstommen. Du ska nu göra en doku-
mentmall för ett formulär  som används för plockning av komponenter från ett förråd. 
Förlagan PLOCKNINGSLISTA finns direkt efter förlagan för försättsbladet. Börja 
med att skapa layout och lägg in de fasta texterna. I avsnittet Word, sammanfattning – 
Formulär  (häftet) finns instruktioner för design av formulär. 
 
Anvisningar för inställning av egenskaperna till dina kontroller: 

 - Datum och tid ska sättas automatiskt med var sitt fält . 
 - Projekt ska följas av ett textfält  med 30 teckens begränsning. 
 - Avdelning ska följas av en kombinationsruta med tre valmöjligheter. 
 - Beställare ska följas av ett textfält  med standardtext innehållande ditt namn. 

 - Klart före ska följas av ett textfält  som behöver 10 tecken. 
 - Leveranssätt bestäms med två kryssrutor . 
 - Antal ska kunna ges i ett textfält  med max 5 siffror (typen nummer). 
 - Komponent... textfält  med 30 tecken.  
 - Hylla ska kunna väljas bland A1-A4, med A1 som första element i en  

kombinationsruta. 
 - Fack anges i ett textfält  med 4 tecken. 

- Ange namn! ska vara standardtexten i ett textfält  med 30 teckens begränsning. 
 

Skydda ditt formulär enligt instruktionerna för design och spara det som dokumentmall.  
Skapa ett nytt dokument (Office-knappen → Nytt ) med din nya mall och testa. 
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"Rubrik här"  
 
 

"Kort sammanfattning"  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Datum: 2009-08-14  
Namn:  Mitt förnamn och efternamn 
Personnr: Mitt personnummer 
Program: Mitt program 
Kurs: Kurs 

Sidhuvudet 

MacroButton →  
AccepteraMarkeradeÄndringar 

Retur 2 
 
 

 

Godkänd 

Retur 1 
 
 

 Ej i sidfoten 

MacroButton →  
AccepteraMarkeradeÄndringar 

DATE \* MERGEFORMAT 
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{MACROBUTTON 
AccepteraMarkeradeÄndringar "Rubrik här"} 

 
 

{MACROBUTTON Acceptera MarkeradeÄndringar "Kort samanfattning"} 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Datum: {DATE \* MERGEFORMAT} 
Namn:  Mitt förnamn och efternamn 
Personnr: Mitt personnummer 
Program: Mitt program 
Kurs: Kurs  

Retur 2 
 
 

 

Godkänd 

Retur 1 
 
 

 



 
 Datum: 2009-10-01 
 Tid: 16:51:46 
 
 
 
 
 
 

Plockningslista 
 
 
Projekt:       
 
Avdelning: Avd 1 Beställare: Anders Andersson 
 
Klart före:        Hämtas  Levereras till avd. 
 
Antal Komponenttyp, namn, nummer, mm Hylla Fack 
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
            A1       
 
 
 
 
Plockat av: Ange namn!  

Linje från Figurer 

Textfält 
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Övning i PowerPoint 
 

Presentationsmall 
 
I PowerPoint finns en hel uppsättning mallar, den ena färggrannare än den andra, som man 
kan välja som bakgrund för sina presentationer. Vi ska börja med att utöka skaran med en 
egentillverkad mall. Därefter är uppgiften att göra en presentation (ett bildspel). Gör så här: 
 

1. Skapa mappen PowerPointpresentationer i din användarmapp (hemkatalog). 
 

2. Starta PowerPoint. (Det ska startas med vara en Tom presentation, dvs den vanliga 
mallen som finns på den lokala disken.)  
 
Ställ in standarkatalogen på M:\Pcsa\ PowerPointpresentationer. Det gör man i 
Office-knappen → PowerPoint-alternativ → Spara. 
 
Observera att M:\Pcsa\Mallar fortfarande ska användas för dina mallar, både för 
Word och PowerPoint. 

 
3. Du ska nu skapa en bildbakgrund som ska vara gemensam för alla bilder i 

presentationen.  
 
Gå till Design → Teman för att välja ett tema, färger och bakgrundformat 
(exempelvis toning). 
 
Gå till Infoga → Text för att lägga in en sidfot. Aktivera datum och tid, bildnummer 
och sidfot med texten Örebro universitet/Teknik. Klicka på Används för alla. 
 
Förvissa dig om att visningsläget är bildbakgrund: Visa → Presentationsvyer → 
Bildbakgrund. Gå till Infoga → Illustrationer → Bild och hämta in valfri 
universitetslogo från N:\Logos.  
 
Beskär (Bildverktyg → Format → Storlek → Beskär) bilden så att endast loggan 
visas, dvs. ta bort texten.  
 
Förminska bilden rejält och placera den i övre vänstra hörnet. 
 
Gör de vita delarna i loggan transparent så att bakgrundfärgen visas (Bildverktyg → 
Format → Justera → Ändra Färg). 
 
Gå över visningsläget Normal. Klicka på Start-fliken. Spara som Makroaktiverad 
PowerPoint-mall (*.potm) med valfritt namn. 
 
Stäng mallen. Välj Office-knappen → Nytt för att öppna din nya mall från  
Mina mallar. 
 
Testa att skapa nya bilder (sidor i en presentation) med Start → Ny bild. Välj olika 
layouter för att förvissa dig om att alla får lika bakgrund. 
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Presentation 
 
Använd din nya mall för att göra en kort presentation av valfritt ämne, exempelvis dig själv. 
Den ska innehålla minst tre bilder (dvs tre sidor i bildspelet) med bildobjekt (ClipArt och 
fotografier från t ex Internet). Gör animeringar och bildövergångar. Gör till sist bildspelet 
självgående med lämpliga tidsinställningar. 
 
Presentationer sparas med filformatet PowerPoint-presentation (*.pptx) eller 
Makroaktiverad PowerPoint-presentation (*.pptm). Du bör använda det senare för denna 
presentation. Använd mappen M:\Pcsa\ PowerPointpresentationer för att spara. 
 
Bildspelet ska visas inför kurskamraterna och en åhörarkopia (utskrift med tre bilder per sida) 
ska lämnas in. (Utskriften ska finnas med i det häfte som du kommer att redovisa.) 
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Tillämpning av EXCEL  
 

Lösning av en ekvation av 3:e ordningen 
 
 
Uppgift 
 
Många tekniska problem leder fram till uppgiften att lösa en ekvation av högre ordning. 
Problemet är då att man ofta inte kan presentera någon explicit lösning utan är hänvisad till en 
iterativ lösning. EXCEL ger oss en utmärkt möjlighet till att utföra en sådan iteration 
(målsökning), t ex att i ekvationen 
 

y = a·x3 + b·x2 + c·x + d 
 
bestämma de tre x-värdena som ger y = 0. 
 
 
Indata 
 
Koefficienter  a, b och c 
Konstant  d 
 
 
 
Målsökning 
 
En tabell över iterationsfunktionen y tas fram för värden på x som ligger i lämpligt område. 
Ett diagram över y presenteras där man grovt kan se vilka värden på x som ger lösningen 
y = 0. Utför sedan iterationer (målsökning) för att mera exakt bestämma de tre värdena på x. 
 
I tabellen skall ingå värden på x och y.  
 
Se de följande bilderna Cellreferens 1-3, Diagram1-5 och Målsökning. 
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Excel – Sammanfattning 
 

Ny arbetsbok 
 
Bok1 Programmet startar direkt med Bok1 om du inte har ställt in något 

annat.  
 
Blad1 Boken innehåller normalt 3 blad, vars namn går att ändra genom att 

dubbelklicka på respektive bladflik. 
 
Sidor Varje blad går att dela in i ett stort antal sidor av exempelvis A4-

format. Oftast är det enklast att ha en sida på varje blad. 
 
 

Formatering 
 
Celler All text och alla tal skrivs in i celler. Varje cell har en cellreferens 

(ex. A1, C4, etc.) Normalt blir texten vänsterställd och talen 
högerställda. Texten kan vara bredare än cellen och skrivs då över 
nästa cell till höger. Om däremot talen blir för ”breda” visas ##### 
i cellen. 

 
Rad/kolumn-format Radhöjd och kolumnbredd kan justeras med musen eller i denna 

meny. 
 
Cellformat På Start-fliken kan teckensnitt, justering, kantlinjer, etc. ställas in. 

Man kan sammanfoga markerade celler med Start → Stycke → 
Centrera över kolumner och även välja Start → Stycke → 
Radbryt text för att få texten på flera rader i cellen. 

 
Stödlinjer Stödlinjer (rutnätet) kan visas/döljas på två sätt, antingen på bladet 

eller endast ”på pappret” vid utskrift.  
På bladet: Visa → Visa/dölj → Stödlinjer  
eller Sidlayout → Stödlinjer → Visa.  
Endast på pappret: Sidlayout → Utskriftsformat → pilen till 
höger i dialogrutan → Blad → Stödlinjer  

 
eller Sidlayout → Alternativ → pilen till höger i dialogrutan → 
Stödlinjer → Blad → Stödlinjer             

 

Redigering 
 
Redigera, Kopiera, Cellernas innehåll kan flyttas eller kopieras till andra celler med 
Klistra in  hjälp funktionerna i Start → Urklipp eller med musen (höger-

klicka). 
 
Fyllfunktionen Om markören placeras längst ner till höger i en markerad cell eller 

ett område, omvandlas den till ett svart plus. Om du då drar med 
musen fylls cellerna med någon slags serie, beroende på vad de 
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markerade cellerna innehåller. Du kan även kopiera formler på 
detta sätt. 

 Exempel: Om du skriver Januari i en cell och använder fyll-
funktionen, så får du automatiskt de övriga månaderna i de celler 
som ”fylls”. 

 
Kantlinjer  I Start → Tecken → Kantlinjer kan du sätta in kantlinjer runt och  
 markerade områden. 
 
 
Talformat I  Start → Format → Cellformat eller Start → Tal → Talformat 

kan du välja hur tal ska presenteras i cellerna, bl a 
tusentalsavgränsning, antal decimaler, etc.  

 
Centrera över Rubriker kan centreras över flera kolumner. Skriv texten i den   
kolumner ”vänstraste” kolumnen, markera önskade celler och klicka på  

Start → Justering → Centrera över kolumner → Centrera över 
kolumner. 

 
 

Formler 
 
Formelguiden Det finns ett stort antal fördefinierade formler både för beräkningar 

och textbearbetning. Formler kan skrivas manuellt (inleds då alltid 
med =) eller med hjälp av en formelguid eller som en kombination 
av båda metoderna. I cellen visas alltid värdet av beräkningen 
medan formeln visas i redigeringsfönstret. Formelguider finns i 
Start → Redigering och framför allt på Formler–fliken. 

 
Summa De vanligast förekommande formlerna har fått en egen knapp. Det 

gäller bl a summering av kolumner respektive rader. Den finns i 
Start → Redigering. Placera markören i den cell där summan ska 
anges, och klicka på summaknappen. Programmet försöker lista ut 
vilka celler som avses. Justering av urvalet kan göras med musen. 

 
Cellreferenser I formler anges variabler såsom cellreferenser, exempelvis C4. Vid 

kopiering eller flyttning ändras referenserna i ”motsvarande grad”  
Ex: =$C$4*0,25 om inte dessa gjorts till absoluta referenser genom att placera 
eller: =C4*0,25 dollartecken framför tecknen: $C$4 (alternativt kan F4 användas då 

markören står vid cellreferensen). Referenser kan göras till andra 
blad i boken, exempelvis Blad2!$C4. Ett, ofta bättre, alternativ är 
att namnge den cell som innehåller ett värde som man önskar 
använda som fast referens. Då slipper man ange bladnamn i 
referensen. Se nästa stycke. 

 
Områden I vissa formler används hela 

områden av celler som 
underlag. Dessa kan anges på 
formen A1:B3 men bättre är 
att ge området ett namn. 
Markera området och klicka i 
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namnrutan samt ange önskat namn. Skriv direkt i namnrutan eller 
höger-klicka och välj Namnge ett område. 

 
 
Funktionssammanfattning 
 
Här följer några av de vanligaste funktionerna 
OBS! Funktionerna ska normalt placeras i de celler, där resultatet ska hamna. 
 
 
Funktion Argument (exempel) Resultat 
   
= A1 * B2  Multiplicerar värdena i cell A1 och B2 
SUMMA (A1:A4) Summerar värdena i cellerna A1 till A4 
MEDEL (A1:A4) Beräknar medelvärdet för cellerna A1 till 

A4 
AVRUNDA (A1;2) Avrundar värdet i A1 till 2 decimaler 
HELTAL (A1) Anger heltalsdelen av talet i A1 
LETARAD (A1;Tabell;2;0) Tar värdet i A1, går till Tabell, letar upp 

A1-värdet i kolumn 1 och returnerar det 
värde som finns på samma rad men i 
kolumn 2 

LETAKOLUMN (A1;Tabell;2;0) Tar värdet i A1, går till Tabell, letar upp 
A1-värdet i rad 1 och returnerar det värde 
som finns i samma kolumn men i rad 2 

OM (A1>5;”Stort”;”Litet”) Skriver Stort i cellen om värdet i A1 är 
större än 5, i annat fall Litet 

ÄRFEL (A1/A2) Ger värdet Sant om det uppstått ett 
formelfel i divisionen (om A2=0) 

DATUM () Ger aktuellt datum 
 
 

Sidhuvud/sidfot 
 
Utskriftsformat I  Infoga → Text → Sidhuvud/sidfot kan sidhuvud och sidfot 

redigeras. Liksom i Word går det att infoga fält för exempelvis 
dokumentnamn. Sidhuvudet är indelat i tre delar, en vänsterställd, 
en centrerad och en högerställd. Om du har flera blad i arbetsboken 
så ”klickar du ihop” bladen först med Ctrl-tangenten nedtryckt, för 
att sidhuvudet/sidfoten ska gälla för samtliga blad. 
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Diagram 
 
Infoga Diagram skapas enklast genom att markera önskade värden i en 

kalkyltabell och därefter välja diagramtyp i Infoga → Diagram.  
Det är viktigt att markeringen är symmetrisk. Rubriker kan tas med, 
använd Ctrl-tangenten vid delad markering. Undvik framför allt 
tomma kolumner och rader. Tänk på att kolumner kan vara 
”skymda” av text. 

 
 I Infoga → Diagram kan du välja diagramtyp, skriva rubriker och 

få förklaringar samt påverka diagrammets grundstruktur. Den 
slutliga finjusteringen av diagrammet görs efteråt val av typ.  

 
Redigering Börja med att justera diagramrutan till önskad storlek. Så länge 

diagrammet är markerat kan du alltid starta om valet av diagram. 
 
 Huvudregeln vid redigering är att klicka med höger musknapp på 

den detalj du vill förändra och sedan välja i menyn som visas. 
 
 Om du upptäcker att diagrammet inte alls motsvarar dina högt 

ställda förväntningar, är det oftast smidigast att ta bort det och 
starta guiden på nytt, eventuellt med en annan markering, prova dig 
fram! 

 
Uppdatering Observera att det hela tiden finns en länk mellan data och diagram. 

Om du ändrar något värde i den tabell som diagrammet baseras på, 
kommer även diagrammet att ändras. 

 
 

Mallar 
 
Skapa mall En mall skapas likadant som en arbetsbok. Däremot ska den sparas 

som en mall (.xltx eller som makroaktiverad mall med .xltm), i 
katalogen C:\Pcsa\Mallar. Sökväg till katalogen ställs in under 
Office-knappen → Excel-alternativ → Spara. Mallar som sparas 
så, blir valbara om du startar med Office-knappen → Nytt.  

 
Redigera mall Om du behöver ändra något i en mall, går du till Office-knappen 

→ Öppna, väljer önskad mall och redigerar på vanligt sätt. 
 
 
Diagrammallar Det går att spara ett färdigt diagram som en mall. Med diagrammet 

markerat, går du till Diagramverktyg, Design→ Typ → Spara 
som mall.  Ange ett namn för mallen och klicka på OK. Mallen 
kommer sedan att finnas med på Infoga→ Diagram → Andra 
diagram → Alla diagramtyper → Mallar. 
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Importera textfiler 
 
Textkonverteraren Om en textfil importeras till Excel utan konvertering, hamnar all 

texten i en enda cell. Använd därför Data → Hämta externa data 
→ Från text. (Om Office-knappen → Öppna används för att 
öppna en textfil, startas textkonverteraren automatsikt.) 
Konverteraren kan också nås via Data → Dataverktyg → Text till 
kolumner om du vill göra indelningen av en redan importerad fil. 

 
Internet Om du vill hämta en tabell från Internet för redigering i Excel, bör 

du spara hemsidan som Text File (*.txt). Alternativt kan du 
använda Kopiera , Klistra in på vanligt sätt. 

 
 I textkonverteraren kan du välja mellan att avskilja kolumnerna 

med speciella tecken (exempelvis tab.) eller indela med fasta 
bredder. Det senare är oftast mest användbart. I guidens nästa steg 
har du möjlighet att lägga in och ta bort avgränsningslinjer. Skrolla 
i texten för att kontrollera att kolumnerna blir korrekt avgränsade. 
Rubriker och eftertexter kan redigeras i efterhand. När du avslutar 
guiden läggs texten in i cellerna. 

 
Decimalpunkt Om den infogade tabellen kommer exempelvis från USA, är den 

försedd med decimalpunkter istället för decimalkomman. Detta kan 
åtgärdas antingen genom att ställa om Windows grundinställningar 
eller också genom att använda Start → Redigera → Sök och 
markera → Ersätt. 

 

Makron 
 
Precis som i Word kan man spela in, skriva och redigera makron. Det inspelade makrot går att 
studera i en speciell Visual Basic-editor. 
 
Spela in makro I Visa → Makron → Makron → Spela in makro ska du namnge 

makrot. Du kan  
 också knyta det till en tangentkombination (kortkommando) i rutan 

Ctrl+.  Du kan även lägga in en knapp på kalkylbladet eller i ett 
verktygsfält och knyta makrot till den. Glöm inte att stoppa 
inspelning. 

 
Spela upp makro I Visa → Makron → Makron → Visa  makron kan makrot köras 

och redigeras, men för körning kan ett tilldelats kortkommando 
vara enklare att använda. 

 
 

Databaser 
 
Listor Databaser i Excel skapas på samma sätt som i Word (tabell-

funktionen) genom att ett antal kolumner tilldelas fältnamn och 
varje rad utgör en post. En sådan uppställning kallas lista. 
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Sortering Listorna kan sorteras utifrån valfri kolumn, enklast med hjälp av 

sorteringsknapparna. Placera markören i önskad kolumn och klicka 
på önskad knapp. 

 
Filter Med hjälp av Data → Sortera och filtrera → Filter kan du söka i 

databasen. Du kan ange sökvillkor för valfritt fält. Resultatet av 
sökningen presenteras i form av ett urval av poster - de övriga 
posterna döljs. 

 
Avancerat filter Med  Data → Sortera och filtrera → Avancerat kan du ange 

sökvillkor på ett valfritt ställe på bladet och även placera urvalet på 
valfritt ställe. Dessutom kan du bestämma vilka fält som ska visas. 

Fältnamn 

Post 
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Diverse tips 
 
Använd hjälp En mycket underskattad funktion. Lär dig att använda den!!! 

Hjälpen aktiveras med [F1]. 
 

Pivottabeller En pivottabell utgör i princip en sammanfattning av en större  
tabell, där delsummeringar kan göras antingen kolumn- eller 
radvis. 

 
Zooma markerat Välj Visa → Zooma → Zooma in markering. 
område 
 
Visa ej nollresultat Det finns flera sätt att dölja de förargliga nollorna som visas när en 

formel ger resultatet 0. Det enklaste är att välja ett anpassat 
talformat. Gå till Start → Tal → Talformat → Fler talformat 
och välj Anpassat. I rutan Typ skriver du #. 

 
 
Fyllfunktionen Om du använder höger musknapp vid fyllning, påverkas inte 

formateringen (exempelvis kantlinjer) i de rutor som fylls. Du kan 
också använda Start → Tecken → Fyllningsfärg. 

 
Dölja cellinnehåll Ibland tvingas man göra beräkningar i flera led i celler, vars 

innehåll inte ska vara synligt. Markera det område som du vill 
dölja, gå till Start → Tal → Talformat → Fler talformat och välj 
Anpassat. I rutan Typ skriver du ;;; vilket innebär ”tomt” format. 

 
Skydda, lås   Granska → Ändringar kan låsningar av olika typ göras för att 

skydda informationen i arbetsböcker. Naturligtvis gäller detta även 
för format på celler och storlekar på exempelvis bilder. 

 
Målsökning  Används vid anpassning av någon parameter i en formel för att nå 

ett önskat slutresultat. Målsökning hanteras med Data → 
Dataverktyg → Vad händer om-analys → Målsökning. 
 

Problemlösare Den är användbar vid sökning av max- eller minvärden för en 
formel och vid optimering. Aktivera problemlösaren på Office-
knappen → Excel-alternativ → Tillägg. 
 

Scenarier Används när man vill jämföra olika alternativ och se vilken effekt 
de ger på t ex lönsamheten i en verksamhet. Scenarier hanteras med 
Data → Dataverktyg → Vad händer om-analys → 
Scenariohanteraren. 
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Övningar i Excel 

Grundinställningar i EXCEL-miljön 
 
 
Skapa mappen M:\Pcsa\Excelböcker och ställ in sökvägen enligt Excel (OH) - Sökväg.  
 
I följande övning ska fyra arbetsblad användas. Starta Excel och infoga ett nytt blad. Gör 
därefter följande inställningar gemensamma för de fyra bladen: 
 
Markera samtliga bladflikar, använd Ctrl-tangenten. Gå till Sidlayout → Utskriftsformat → 
pilen till höger i dialogrutan → Sida. 
 
Under Skalning: Bocka för Passa 1 s bredd med 1 i höjd.  
 
På fliken Marginaler väljer du Vänster: 2,5 cm och Höger: 2,5 cm samt Centrera: Vågrätt.  
 
På fliken Sidhuvud/sidfot och Anpassa sidhuvud…fyller du i Till vänster med [kursnamn] 
och Mitt i med [signatur och datum]1.  
 
Under Anpassa sidfot…: Till vänster fyller du i [filnamn] och Mitt i [sida av antal sidor].  
 
OBS! Avsluta med att klicka bort ”sammanhållningen” av bladen. 
 
Spara den inställda arbetsboken på formatet Excel-arbetsbok (*.xlsx) i den nya mappen. Gör 
två kopior, en för varje Excel-övning. 
 

Övning 1 
1. Hämta filerna formfakt.dbs (öppna och spara ner som textfil) och formfakt.dwg (klicka på 

ikonen och spara bilden utan att öppna) från kurssidan till mappen ovan. 
 

2. Importera (Data → Hämta externa data → Från text) innehållet i textfilen 
(ursprungligen formfakt.dwg) till en av de nya arbetsböckerna. (Ändra filformatet till 
Alla filer (*.*) om du inte ser den. ) 
 
Ursprunglig datatyp: Avgränsade fält! 
Avgränsare: Blanksteg 
Kolumndataformat: Allmänt.  
(Generellt: fortsätt med Nästa mellan varje fönster i guiden.) 

  
3. Ersätt  .  med  ,  i tabellerna med hjälp av Start → Redigering → Ersätt.  

 
4. Redigera tabellerna efter den förlaga som finns bilagan. Figuren finns att hämta, se nedan. 
 
5. Ändra det första bladets namn till Formfaktortabeller. Spara. Förhandsgranska.  
 
                                                 
1 Datum, filnamn och sidnumrering ska vara "automatiska", använd knapparna. 
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6. En figur skall infogas efter huvudrubriken på det första bladet. Infoga först minst 16 
blanka rader. Öppna filen formfakt.dwg  som innehåller en lämplig figur. Placera figuren 
på klippbordet med [Ctrl] + [C], växla över till din arbetsbok och klistra in figuren efter 
huvudrubriken. Välj återigen förhandsgranska för att se hur utskriften kommer att bli. 

 
7. Ändra namnet på de tre övriga bladen till: Formfaktor vid böjning, Formfaktor vid 

vridning och Formfaktor vid dragning. Bladens ordningsföljd skall vara densamma, dock 
med Formfaktortabeller först. 

 
8. Markera värdena i böjningstabellen. Konstruera ett diagram över formfaktorerna vid 

böjning. Välj diagramtypen Punkt med utjämnade linjer. Placera diagrammet på bladet 
Formfaktor vid böjning. Samma procedur för de två andra diagrammen. 

 
9. Vid utskrift av arbetsboken ska alla bladflikar vara markerade, använd Ctrl-tangenten. 

Detta ger fortlöpande numrering av bladen. 
 

 



Datoranvändning Excelövning JPZ 
  (Ursprungligen för Excel 97 av SBN och SAE) 
 

 85 

Formfaktor 
Del av sidan 1: 
 
 

 
 
 

Formfaktorer vid böjning/vridning/dragning av en ansatsaxel

Böjning: αb     1:a rad: D/d    1:a kolumn: ρ/d
1,01 1,02 1,05 1,20 2,00

0,02 1,84 2,00 2,30 2,55 2,85
0,04 1,60 1,72 1,86 2,08 2,32
0,06 1,48 1,59 1,70 1,85 2,03
0,08 1,40 1,50 1,60 1,71 1,86
0,10 1,35 1,44 1,53 1,62 1,73
0,12 1,31 1,39 1,48 1,55 1,64
0,14 1,27 1,35 1,43 1,50 1,58
0,16 1,24 1,32 1,40 1,45 1,52
0,18 1,22 1,29 1,37 1,42 1,48
0,20 1,20 1,27 1,34 1,39 1,44
0,22 1,18 1,25 1,32 1,36 1,41
0,24 1,17 1,23 1,30 1,34 1,38
0,26 1,16 1,22 1,28 1,32 1,35
0,28 1,15 1,21 1,26 1,30 1,32
0,30 1,14 1,20 1,25 1,28 1,30

Mb
 F Mv

 ρ

       Figur

  φD
  φd
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Diagram 1: 
 

 
 
 

Formfaktor α b vid böjning

1,00

1,50

2,00

2,50

3,00

0,02 0,04 0,06 0,08 0,10 0,12 0,14 0,16 0,18 0,20 0,22 0,24 0,26 0,28 0,30

ρ /d

α b

1,01

1,02

1,05

1,20

2,00
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Innehållet i filen formfakt.dbs 
 
##############  [drive:]\excelovn\formfakt.dbs  970528-SAE  ################ 
 
Filen  innehåller  formfaktorer  för  en  ansatsaxel  vid  belastningarna   böjning,   
vridning   och dragning. 
 
----- Böjning: alfa b  (1:a rad: D/d ,  1:a kolumn: r/d ,  element (1, 1): dummy) ----- 
 
 0.00  1.01  1.02  1.05  1.20  2.00 
 0.02  1.84  2.00  2.30  2.55  2.85 
 0.04  1.60  1.72  1.86  2.08  2.32 
 0.06  1.48  1.59  1.70  1.85  2.03 
 0.08  1.40  1.50  1.60  1.71  1.86 
 0.10  1.35  1.44  1.53  1.62  1.73 
 0.12  1.31  1.39  1.48  1.55  1.64 
 0.14  1.27  1.35  1.43  1.50  1.58 
 0.16  1.24  1.32  1.40  1.45  1.52 
 0.18  1.22  1.29  1.37  1.42  1.48 
 0.20  1.20  1.26  1.34  1.39  1.44 
 0.22  1.18  1.24  1.32  1.36  1.41 
 0.24  1.17  1.23  1.30  1.34  1.38 
 0.26  1.16  1.22  1.28  1.32  1.35 
 0.28  1.15  1.21  1.26  1.30  1.32 
 0.30  1.14  1.20  1.25  1.28  1.30 
 
 
----- Vridning: alfa v  (1:a rad: D/d ,  1:a kolumn: r/d ,  element (1, 1): dummy) ----- 
 
 0.00  1.05  1.10  1.20  1.30  2.00 
 0.02  1.31  1.60  2.00  2.15  2.25 
 0.04  1.20  1.38  1.66  1.75  1.85 
 0.06  1.14  1.27  1.50  1.56  1.65 
 0.08  1.11  1.22  1.40  1.46  1.53 
 0.10  1.10  1.19  1.33  1.39  1.45 
 0.12  1.09  1.17  1.28  1.33  1.40 
 0.14  1.09  1.14  1.25  1.29  1.35 
 0.16  1.08  1.13  1.21  1.25  1.31 
 0.18  1.08  1.12  1.19  1.23  1.28 
 0.20  1.07  1.11  1.17  1.21  1.26 
 0.22  1.07  1.10  1.16  1.20  1.24 
 0.24  1.06  1.10  1.15  1.18  1.22 
 0.26  1.06  1.09  1.14  1.17  1.21 
 0.28  1.06  1.09  1.13  1.16  1.20 
 0.30  1.06  1.09  1.12  1.15  1.19 
 
 
----- Dragning: alfa d  (1:a rad: D/d ,  1:a kolumn: r/d ,  element (1, 1): dummy) ----- 
 
 0.00  1.01  1.02  1.05  1.10  1.20  1.30  1.50  2.00 
 0.02  1.59  1.80  2.20  2.40  2.60  2.80  3.10  3.50 
 0.04  1.43  1.59  1.80  2.00  2.26  2.40  2.60  2.80 
 0.06  1.33  1.46  1.62  1.77  1.99  2.09  2.21  2.37 
 0.08  1.28  1.38  1.52  1.64  1.80  1.91  2.01  2.12 
 0.10  1.24  1.33  1.46  1.56  1.69  1.78  1.88  1.98 
 0.12  1.21  1.30  1.41  1.50  1.61  1.69  1.78  1.89 
 0.14  1.19  1.27  1.37  1.45  1.55  1.62  1.71  1.80 
 0.16  1.17  1.25  1.35  1.42  1.50  1.57  1.65  1.74 
 0.18  1.16  1.23  1.32  1.39  1.47  1.52  1.60  1.68 
 0.20  1.15  1.22  1.31  1.36  1.44  1.49  1.55  1.63 
 0.22  1.14  1.21  1.29  1.34  1.41  1.46  1.52  1.59 
 0.24  1.13  1.20  1.27  1.32  1.38  1.44  1.49  1.55 
 0.26  1.12  1.20  1.26  1.31  1.36  1.42  1.47  1.52 
 0.28  1.12  1.19  1.25  1.29  1.34  1.40  1.45  1.50 
 0.30  1.12  1.19  1.24  1.28  1.33  1.39  1.43  1.48 
 
######################################################################### 
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Övning 2 
 
Lös ekvationen  
 
med hjälp av målsökningsfunktionen i Excel.  
 
Rita först grafen för vänsterledet vilket ger närmevärden för lösningarna. Anpassa x-värdena 
så att grafen tydligt visar nollgenomgångarna. Redovisa diagram, värdetabell och 
målsökningen. 
 
Följ det tidigare exemplet ”Tillämpning av Excel – Lösningar av en ekvation av 3:e 
ordningen” och de tillhörande figurerna: Cellreferens1-3, Diagram1-5 och Målsökning. 
Använd ett diagram av typen Punkt med utjämnade linjer. 
 
Det ska redan finnas en inställd Excel-arbetsbok för övningen i din M:\Pcsa\Excelböcker. 
 
 

023325,0 234 =+−−+ xxxx
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Python 

Programexempel 

Ex. 1 
 
# hej.pyw v2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Programmet skriver ”Hello world!" på bildskärmen  
 
print("Hello world!")    # Utmatning på bildskärmen 
 
 

 

 
 

 
 
 
Programmet ger följande utskrift: 
 
Hello world! 
 

Ex. 2 
 
# skatt.pyw v2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Programmet beräknar priset inklusive skatt 
 
skatt = 2.75/100 
pris = 100.50 
pris = pris * (1 + skatt) 
print("Priset = ", pris) 
print("Priset med två decimaler är ", round(pris,2)) 
 
 

 
 
 

 
 
Programmet ger följande utskrift: 
 
Priset =  103.26375 
Priset med två decimaler är  103.26 
 

Ett #-tecken i den första positionen (kolumnen) betyder kommentar. 
Ett #-tecken efter sats ger också plats för en kommentar. 
Det går bra att lägga in tomma rader. Se den femte raden i källkoden. 

Funktionen round(x,d) ger avrundning med d decimaler av ett reellt tal 
x. 
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Ex. 3 
 
# strang.pyw v2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Programmet ger utmatningsexempel 
 
my_text = "This is a rather long string containing\n\ 
several lines of text just as you would do in C.\n\ 
    Note that whitespace at the beginning of the line is\ 
 significant." 
print(my_text) 
 
print("\"'\"") 
print(r"Test av \n") 
 
my_text = "räven raskar " + "över " "isen   " 
print(my_text*3) 
 
my_text = "räven raskar över isen " 
print(my_text) 
 
print('\xe5 \xe4 \xf6 \xc5 \xc4 \xd6 \xd7 \xd8') 
 
 

 
 
 
 
 
 
 
 
 

 
 
Programmet ger följande utskrift: 
 
This is a rather long string containing 
several lines of text just as you would do in C. 
    Note that whitespace at the beginning of the line is significant. 
"'" 
Test of \n 
räven raskar över isen   räven raskar över isen   räven raskar över isen 
räven raskar över isen  
å ä ö Å Ä Ö × Ø 
 

Ett \-tecken ger fortsättning av strängen på nästa rad. 
Tecknen \n ger new line. 
Tecknen \” ger ett tecknet ” på bildskärmen. 
Tecknet r som står innan "Test of \n" betyder raw. 
Att sätta ihop strängar kallas konkatenering. 
Strängar kan upprepas med hjälp av *-tecknet. 
Strängar kan skrivas inom "-tecken eller inom '-tecken. 



Datoranvändning Python JPZ 

 91 

Ex. 4 
 
# fler_strangar.pyw v2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Exempel på string 
 
word = 'abc' 
word = word + 'de' 
 
print(word[0]) 
print(word[1]) 
print(word[0:2]) 
print(word[2:4]) 
print(word[0:5]) 
print(word[-5]) 
 
 

 
 
 
 
 
 
 
 
 
 

 
 
Programmet ger följande utskrift: 
 
a 
b 
ab 
cd 
abcde 
a 
 

En sträng kan behandlas som en lista (kallas array i några 
andra språk), dvs. tecknen kan ses som element. Varje 
element kan kommas åt med sitt index (placeringsnummer). 
 
Tecken a b c d e 
Index 0 1 2 3 4 

Negativt 
index 

-5 -4 -3 -2 -1 
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Ex. 5 
 
# listor.pyw v2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Exempel på listor 
 
a = ['ole ', 'dole ', 'till', 1000] 
print(a) 
print(a[2:4]*3 + ['hick!']) 
print(a[0] + a[1] + a[2], a[3]) 
 
a[2] = 'doff' 
a[3] = a[3] + 111 
print(a) 
 
a[0:2] = [] 
print(a) 
 
a[1:1] = ['ny ', 'giv', 'med'] 
print(a) 
 
b = ['spanska', a, 'räven'] 
print(b) 
print(len(a),"och", len (b)) 
print(b[1][4]) 
 
 
Programmet ger följande utskrift: 
 
['ole ', 'dole ', 'till', 1000] 
['till', 1000, 'till', 1000, 'till', 1000, 'hick!'] 
ole dole till 1000 
['ole ', 'dole ', 'doff', 1111] 
['doff', 1111] 
['doff', 'ny ', 'giv', 'med', 1111] 
['spanska', ['doff', 'ny ', 'giv', 'med', 1111], 'räven'] 
5 och 3 
1111 
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Ex. 6 
 
# fibonacci_en_rad.pyw v2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Fibonacci-serie: summan av två element definierar nästa element 
 
a, b = 0, 1 
while b < 1000: 
    print(b, end=' ') 
    a, b = b, a+b 
 

 
 
 
 
 
 
 
 
 

 
 
Programmet ger följande utskrift: 
 
1 1 2 3 5 8 13 21 34 55 89 144 233 377 610 987 
 

Ex. 7 
 
# for_lista.pyw v.2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Exempel på listor 
 
y = int(input('Ge ett heltal: ')) 
print() 
print('Sida  Kvadrat   Kub') 
print('='*19) 
for x in range(1, y + 1): 
    print('%3d %6d %7d' % (x, x*x, x*x*x)) 
print('-'*19) 
 
 
 

Satsen med while ger upprepning av de satser som är 
indenterade ett steg åt höger efter denna. 
Upprepningen görs så länge b  är mindre än 1000. 
Ett komma-tecken (,) följt av end=' ' ger fortsatt utskrift 
(utmatning) på samma rad. Mellanslaget inom '-tecknen ger 
avstånd mellan talen i serien. Om man istället skriver 
end='' matas talen ut tätt efter varandra. 
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Exempel på programkörning: 
 
Ge ett heltal: 15 
 
Sida  Kvadrat   Kub 
=================== 
  1      1       1 
  2      4       8 
  3      9      27 
  4     16      64 
  5     25     125 
  6     36     216 
  7     49     343 
  8     64     512 
  9     81     729 
 10    100    1000 
 11    121    1331 
 12    144    1728 
 13    169    2197 
 14    196    2744 
 15    225    3375 
------------------- 

Inmatning från tangentbordet görs med funktionen 
input(). 
Funktionen int() konverterar en sträng eller ett nummer till 
ett heltal (integer). 
Använd funktionen float() för konvertering av sträng 
eller ett nummer till ett flyttal (reellt tal på speciellt format). 
Upprepningen görs här med for. Så länge som x är i 
intervallet [1, y + 1[ görs upprepningen. Då x = y + 1 är  
x utanför intervallet p.g.a. den öppna övre gränsen och 
loopen avbryts. 
Variabler vars värden ska skrivas ut enligt ett bestämt 
format föregås av %-tecken. Vi har 
('%3d %6d %7d' % (x, x*x, x*x*x)) 
Man kan också skriva x*x som x**2 eller pow(x, 2) och på  
liknande sätt för högre potenser. 
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Ex. 8 
 
# min_funktion.pyw v2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Enkel test av egen funktion 
 
 
# Funktionen funken() 
 
def funken(a, b): 
    ”Beräknar summan av två tal och tar resultatet i kvadrat” 
    sum = a + b 
    res = sum*sum    # res = pow(sum, 2) eller res = sum**2 fungerar också 
    return res 
 
# Allt på en rad blir exempelvis: return (a + b)**2 
 
 
# Huvudprogram (Här startar programmet) 
 
x = funken(1, 3) 
print(x) 
print() 
 
# Eller, varför inte allt på en rad!? 
print(funken(1, 3)) 
print() 
 
# Ytterligare ett par exempel 
print(funken(100, 1)) 
print(funken(0.15, 25)) 
print() 
 
 

 
 
 
 
 
 
 
 
 
 
 

Programmet ger följande utskrift: 
 
16 
 
16 
 
 
10201 
632.5225 
 
 

Underprogram som t.ex. funktioner definieras i början av 
källkoden (innan huvudprogrammet) med def. 
Text inom citattecken (”) tolkas som kommentar – ett 
alternativ till #.  
Argumenten '1' och '3' i funktionsanropet  
funken(1, 3) fångas upp av variablerna a och b. 
Funktionen avbryts med return. 
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Ex. 9 
 
# fraga.pyw v.2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Exempel på if-elif-else och funktion 
 
 
# Funktionen ask_ok() 
 
def ask_ok(prompt, retries, complaint): 
    while True: 
        ok = input(prompt) 
        if ok in ('j', 'ja', 'J', 'Ja', 'JA'): 
            return True 
        elif ok in ('n', 'nej', 'N', 'Nej', 'NEJ'): 
            return False 
        else: 
            retries = retries - 1 
 
        if retries < 0: 
            raise IOError('refusenik user') 
 
        print(complaint) 
 
 
# Huvudprogrammet 
 
ask = ask_ok('zzz> ', 4, 'Ja eller nej, tack!') 
if ask == True: 
    print('Ge mor en kaka!') 
else: 
    print('Stackars mor!') 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Argumenten 'zzz> ', 4 och 'Ja eller nej, tack!' i 
funktionsanropet ask_ok() fångas upp av variablerna 
prompt, retries och complaint. 
I detta fall skickas antingen det logiska värdet True eller 
False tillbaka till huvudprogrammet. 
Inmatning från tangetbordet görs med input(prompt). 
Följande operatorer används i jämförelser: 
 

Operator Innebörd 
< Mindre än 
<= Mindre än eller lika med 
> Större än 
>= Större än eller lika med 
== Lika med 
!= (eller <>) Inte lika med (!= rekommenderas) 
Is Lika identitet 
Is not Inte lika identitet 
In Medlem 
Not in Inte medlem 
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Exempel på programkörningar: 
 
zzz> j 
Ge mor en kaka! 
 
================================= RESTART ================================= 
 
zzz> nej 
Stackars mor! 
 
================================= RESTART ================================= 
 
zzz> flopp 1 
Ja eller nej, tack! 
zzz> flopp 2 
Ja eller nej, tack! 
zzz> flopp 3 
Ja eller nej, tack! 
zzz> flopp 4 
Ja eller nej, tack! 
zzz> flopp 5 
 
Traceback (most recent call last): 
  File "C:\Program\Python24\fraga.pyw", line 27, in <module> 
    ask = ask_ok('zzz> ', 4, 'Ja eller nej, tack!') 
  File "C:\Program\Python24\fraga.pyw", line 20, in ask_ok 
    raise IOError('refusenik user') 
IOError: refusenik user 
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Programmeringsmiljön 
 
Starta IDLE (Python GUI) och finns programgruppen för Python med 
Start – All Programs – Links – Prog – Python 3.1 – IDLE (Python GUI) 
 
Öppna en ny fil med 
File – New Window 
 
Spara den nya filen med 
File – Save As 
och ange filnamnet som exempelvis minfil.pyw. 
 
Observera att filen bör sparas i din hemkatalog M:\Pcsa. Det rekommenderas att du skapar en 
underkatalog i hemkatalogen, t.ex. Python, för dina program. 
 
Kör programmet med 
Run – Run Module 
eller tryck på [F5]. 
 
Uppgifterna (övningarna) ska redovisas med bl.a. källkoden och programkörningarna. 
Källkoden kan kopieras och klistras in i Word. Du kopierar från editorn med 
Edit – Select All 
Edit – Copy 
 
Kopieringen kan resultera i en kopia som exempelvis 
 
# fibonacci.pyw v2.1 
# Jack Pencz (JPZ) 
# Python v3.1 
# Fibonacci-serie: summan av två element definierar nästa element 
 
a, b = 0, 1 
while b < 10: 
    print(b) 
    a, b = b, a+b 
 
 
Programkörningarna visas i Python Shell. Du ska redovisa sådana för de program som du 
kommer att skriva. Man kan kopiera för att sedan klistra in i Word. Du kopierar från Python 
Shell med 
Markera önskad text med musen eller Edit – Select All 
Edit – Copy 
 
Ovanstående program, fibonacci v2.1, ger som exempel följande programkörning: 
 
1 
1 
2 
3 
5 
8 
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Ett alternativ är att först markera Python Shell (som aktivt program) och sedan klicka 
samtidigt på tangenterna [Alt] och [Print Scrn]. ([Alt] maskar ut det aktiva programmet och 
på så sätt minskas bilden från att omfatta hela bildskärmen till endast det aktiva programmet.)  
 
Ovanstående program, fibonacci v2.1, ger som exempel följande programkörning: 
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Övningar i Python 

Uppgifter – Del A 
 
För samtliga uppgifter i del A gäller att du skall redovisa en kort text som beskriver vad 
programmet gör. Dessutom bifogar du källkoden och programkörningsfönstret. 
 

Uppgift 1 
 
Skriv in och kör nedanstående program. Låt IDLE (Python GUI). 
 
# bensinpris.pyw v2.1 
# Ditt namn 
# Python v3.1 
# Bensinpriset beräknas 
 
 
# Funktionen fraga_ok() 
 
def fraga_ok(text, retries, complaint): 
    while True: 
        ok = input(text) 
        print 
        if ok in ('j', 'ja', 'J', 'Ja', 'JA'): 
            return True 
        elif ok in ('n', 'nej', 'N', 'Nej', 'NEJ'): 
            return False 
        else: 
            retries = retries - 1 
 
        if retries < 0: 
            raise IOError('refusenik user') 
 
        print(complaint) 
 
 
 
# Huvudprogrammet 
 
loop = True 
 
while loop == True: 
    literpris = float(input('Literpris = ')) 
    volym = float(input('Antal liter = ')) 
    print() 
     
    totalpris = literpris * volym   # Beräkna totalpriset 
    print('Totalpris =', round(totalpris,2),'kr\n') 
    print() 
 
    loop = fraga_ok('Ny beräkning? ', 3, 'Ja eller nej, tack!') 
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Uppgift 2 
 
Skriv ett program i filen triangel.pyw som frågar efter basen och höjden hos en triangel. 
Därefter beräknar programmet triangelns yta och skriver ut svaret på bildskärmen. Endast en 
beräkning per programkörning är tillräckligt. 
 

Uppgift 3 
 
Skriv ett program i filen korstracka.pyw som läser in en sträcka i km och en medelhastighet i 
km/h. Programmet ska sedan beräkna körtiden och ge svaret skärmen. Låt programmet fråga 
om ny beräkning skall göras eller inte. 

(Uppgifterna 2 och 3 är hämtade från Datoranvändning av Sune Bergelin m.fl.) 
 

Uppgift 4 
 
Skriv ett program i filen person.pyw som läser in förnamn, efternamn och telefonnummer. Låt 
programmet fråga om ny en person ska matas in eller inte. Man får mata in maximalt tio 
personer. När den sista personen har matats in, ska texterna skrivas ut på bildskärmen. 
Använd en lista för in- och utmatning. I listan ska det finnas element av typen konstant (alltid 
detsamma) och variabel (kan ändras). 
 
Utmatningen ska se ut enligt följande exempel: 
 
 1 Namn:    Nils Pyssling 
   Telefon: 011-111111 
 
 2 Namn:    Pippi Långstrump 
   Telefon: 012-222222 
 
 3 Namn:    Fingal Olsson 
   Telefon: 013-333333 
 
… 
 
 
10 Namn:    Homer Simpson 
   Telefon: 555-555555 
 
 
Observera den prydliga indenteringen: ”10” upptar ju två teckenfält och namnen ska stå i 
samma ”kolumn” som personernas telefonnummer. 
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Uppgifter – Del B 
 
Dessa uppgifter är valfria och redovisas på samma sätt som i del A.  
 

Uppgift 1 
 
Skriv ett program i filen multi.pyw som läser in ett heltal och sedan skriver ut motsvarande 
tals multiplikationstabell på skärmen. Avsluta automatiskt vid 10 x inläst tal. Exempel på 
utskrift: 
 
 
 

 

 

Uppgift 2 
 
Skriv ett program i filen hms.pyw som läser in en tid i timmar (behöver ej vara hela timmar) 
och omvandlar till timmar, minuter och sekunder. Låt programmet fråga om ny beräkning 
skall göras eller inte. 
 

5:ans tabell:
––––––––––––- 
  0 x 5 =  0   
  1 x 5 =  5   
  2 x 5 = 10   
  3 x 5 = 15   
    osv. 
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Uppgift 3 
 
Skriv ett program i filen kompass.pyw som frågar efter ett gradtal mellan 0° och 360°. 
Programmet ska sedan ange närmaste väderstreck enligt figuren (N är 0°, NO är 45°, osv. ). 
Programmet ska sedan fortsätta att fråga tills ett gradtal större än 360° ges då programmet 
avslutas. 

 
 
 
 

(Uppgifterna 1-3 är skrivna av Jonas Karlsson i Datoranvändning, författare är Sune Bergelin m.fl.) 

 N 

 O 

 S 

 V 

NO 

SO 

NV 

  SV 
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MatLab (OH) 
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MatLab – Kort instruktion 

Inledning 
 

Denna introduktion till programsystemet MatLab är 
tänkt att ge en första anvisning om handhavandet av 
dess olika delar. Det blir alltså inga djupgående 
exempel på vad programmet kan prestera utan en 
genomgång av grundläggande kommandon för 
inmatning, bearbetning och presentation av data. 

MatLab är en förkortning av Matrix Laboratory, vilket 
ger en fingervisning om att programmet arbetar med 
matriser, all inmatning av variabelvärden sker i 
matrisform. 

 

Exempel: ⎥
⎦

⎤
⎢
⎣

⎡
=

452
321

x  är en matris med två rader 

och tre kolumner. En matris med endast  

en rad eller en kolumn, betraktas normalt som en 
vektor och en matris med endast ett element betraktas 
som en skalär. 

Man arbetar i ett kommandofönster som påminner om 
den gamla hederliga DOS-miljön. Från 
kommandoraden kan man också starta diverse 
tilläggsprogram, för exempelvis plottning av grafer 
och simulering av regler-, elektronik- och 
elkraftsystem. Dessa program kan också startas från 
Launch Pad. 

 

Start av programmet 

 

Välj Links i startmenyn och dubbelklicka på Mathematics-mappen. I denna finns alla 
MatLab-mappar. Välj versionen för stort klassrum. Dubbelklicka därefter på MatLab 7.1 - 
ikonen. 
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Inledande exempel 
 

Tecknen >> innebär att MatLab är redo att ta emot kommandon. Fet kursiv stil = 
inmatningar. 

 

Exempel 1 
 
>> x = [1 2 3; 2 5 4];  % Hakparenteser används för inmatning, 

värdena avgränsas med mellanslag eller 
kommatecken, matrisrader med semikolon. 
Procenttecknet ger möjlighet att lägga in 
kommentarer såsom denna. Om det sista 
semikolonet utelämnas, kommer MatLab att 
skriva ut matrisen som ett resultat av 
inmatningen. 

 
>> x.^2 % MatLab kommer att skriva ut en matris där 

varje element har kvadrerats. Lägg märke till 
punkten, som gör att operationen utförs 
elementvis. 

 

Exempel 2 
 
>> x = [-2:0.1:2]; % x är nu en enradig matris (vektor) med 

värdena (-2.0, -1.9, -1.8, ... 2.0). Lägg 
märke till decimalpunkten! 

 
>> y = 2 * x.^2 - 2.5; % y är nu en vektor med lika många element 

som x och med värden enligt polynomet. 
 
>> plot (x,y) % Startar graf-programmet och ritar upp 

grafen för y = f(x). 
 

Grundfunktioner 

Allmänna kommandon 
 
>> who % listar de variabler som använts under arbets-

passet 
>> dir % listar de m-filer som finns i aktuell katalog (se 

nedan) 
>> type finuf.m % listar innehållet i filen finuf.m 

(kommandoscript) 
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Enkla redigeringstips 
 
• Med piltangenterna ↑↓  kan ”gamla” kommandon bläddras fram och användas igen efter 

eventuell justering. 

• Kommandotext som finns kvar i fönstret kan markeras och därefter kopieras och klistras 
in på den aktuella kommandoraden. 

 
 

Inmatning 
 
Några olika exempel på inmatningar: 
>> x = [1.1 1.2 1.3]; 
 
>> x = [2.3e-6:0.1e-6:8.5e-6]; % i mitten anges avståndet mellan 

värdena 
 
>> x = [-10:10]; % ger x = -10, -9, -8, ... 10 
 
>> x = [ ]; for i = 1: 5, x = [x  i^2], end % ger x = 1 4 9 16 25 
 
Observera att om x = [2 3 4 5 6] så ger x(2) värdet 3 och x(5: -1: 1) värdena 6 5 4 3 2. 

 
 

Inbyggda funktioner 

 

Följande funktioner opererar ”elementvis” : 

sin, cos, tan, exp, log, rem (rest vid div), abs, sqrt (roten ur), floor (heltalsdelen), round 
(avrundning) 

 

Exempel: 
>> x = [0:0.1:2*pi]; 
>> y = sin (x); 
>> plot (x,y) % Ritar en period av sinuskurvan. 
 
 

Följande funktioner opererar på hela matriser: 

max, min, sort, sum, prod, mean, any, all, det (determinanten) 
 
Exempel: 
>> A = [1 2; 3 4]; 
>> max (A) % ger 3 4 
>> max (max (A)) % ger 4 
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Plottning av grafer 

 

Användning av kommandot plot har beskrivits ovan. Lägg märke till att figurfönstret ”hoppar 
fram” endast första gången kommandot används. Fortsättningsvis måste fönstret klickas fram. 
Kommandot Figure(2) öppnar ytterligare ett figurfönster.  

Det finns också ett kommando fplot, som fungerar något annorlunda, exempel: 
>> fplot (‘sin(x)’, [0  4*pi]) % Plottar grafen i angivet intervall 
 
I sammanhanget kan även kommandot fmin (resp. fmax) nämnas, exempel: 
>> fmin (‘sin(x)’, -1, 1) % Ger x-koord. för funktionens minsta 

värde i intervallet. 
 
 
För redigering av diagramytan kan följande kommandon användas: 
>> grid % Lägger in ett rutnät i diagrammet. 
>> title  ‘Rubrik’ % Skapar diagramrubrik. 
>> xlabel  ‘x-axel’ % Rubrik för x-axeln. 
>> ylabel  ‘y-axel’ % Rubrik för y-axeln. 
>> gtext  ‘Kommentar’ % Texten placeras med musen efter att kommandot 

givits. 
>> xlabel  ’x_1’ % ger texten x1. 
 
>> c = [xmin; xmax; ymin; ymax]; 
>> axis (c) % Anger max- och min-värden för respektive 

axel. 
>> axis auto % Återställer. 
 
>> hold on % ”Fryser” diagrammet så att ytterligare grafer 

kan plottas i samma diagram. 
 
För att kunna särskilja grafer i ett diagram kan dessa ”märkas” på följande sätt: 
>> plot (x, y, ‘--’) % ger streckad graf 
>> plot (x, y, ':') % ger punkt-graf 
>> plot (x, y, '-.') % ger punktstreckad graf 
>> plot (x, y, '+') % ger + märkta nodmarkeringar+ kan ersättas med 

*, o eller x 
 

Med kommandot subplot kan man dela in diagramfönstret i flera delar och rita en graf i varje 
delfönster. De flesta av ovanstående kommandon kan även nås via menyer eller knappar i 
figurfönstret. 

 

3D-plot 
 
Tredimensionella grafer skapas genom att först definiera ett "bottenplan" och därefter ange 
hur "taket" ska se ut. Arbetsgången visas med ett exempel: 
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>> xx = -2 : .1 : 2 ; 
>> yy = xx ; 
>> [x, y] = meshgrid (xx, yy) ; % ger "bottenplanet" 
>> z = exp ( - x .^2 - y .^2) ; 
>> mesh (z) 
 
Testa gärna! 

 

m-filer 
 

Med hjälp av s k m-filer (filtillägg .m) kan man spara viktiga delar av "arbetspassen". Det 
finns två typer av m-filer, script files (kommandoscript) och function files (funktionsscript). I 
de förra sparar man körningar som man tror kan vara användbara senare. I funktionsfiler kan 
man skapa egna funktioner, som går att använda på samma sätt som de inbyggda. 

Filerna ska sparas i en mapp med namnet Matlab, som du skapar i din användare, dvs 
sökvägen blir M:\Pcsa\Matlab. 

 

Script files 

 

Ett sätt att skapa dessa är att ge kommandot diary filnamn.m, vilket startar inmatning till 
angiven fil. Därefter gör man själva körningen och avslutar med diary off. Filen sparas 
automatiskt i mappen ovan. 

Ett annat sätt är att skriva alla kommandon man vill utföra i en editor, se nästa avsnitt. 

 

Function files 
 
Det finns en inbyggd editor som lämpligen bör användas för att skriva funktionsfilerna. Den 
kan startas med kommandot edit. 
 
 

Exempel: 
function y = polynom1(x) 
y = 2*x.^3 – 15; 
 
Filen sparas som polynom1.m. Namnet måste vara identiskt med det som angavs före (x). 

Funktionen används enligt: 
>> x = -2 : 0.1 : 3 ; 
>> y = polynom1(x) ; 
>> plot(x,y) 
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Överföring till Word 
 

Grafer överförs enklast (men inte med så god kvalitet) genom att välja Edit | Copy Figure i 
figurfönstret. Först bör man dock ändra i dialogrutan File | Preferences | Copying Options 
till Windows Bitmapp. Det brukar ge bättre kvalitet. Grafen läggs därefter in i 
Worddokumentet med Klistra in (Ctrl+V). 

Önskas bättre kvalitet kan man ge något av kommandona: 
>> print -dtiff M:\Pcsa\Matlab\filnamn.tif 
 
eller 
>> print -deps M:\Pcsa\Matlab\filnamn.ps 
 
I första fallet skapas en bildfil som sedan kan infogas i Worddokumentet med 
Infoga | Bildobjekt | Från fil… I andra fallet skapas en s.k. postscriptfil som antingen kan 
skickas direkt till skrivare eller vidarebehandlas i exempelvis programmet Ghostview. 

Nedan beskrivs två bättre metoder för att överföra graferna till exempelvis Word. 

 

Metod 1 

 

Se till att visningsfönstret är aktivt, tryck på Alt+Print Scrn för att lägga bilden i Urklipp. 
Starta programmet LviewPro (Program | Viewers) och klistra in (Paste) bilden där. Markera 
önskat område och välj Edit | Crop. Välj också Retouch | Negative för att bli av med den 
svarta bakgrunden. En något skarpare bild åstadkommes med Retouch | Image Filters | 
Sharpen. 

 

Använd kopiera, klistra-in för att överföra bilden till Word eller spara den med formatet .tif. 

 

Metod 2 

Resultatet av simuleringen kan också överföras till MatLab för bearbetning med plot-
kommandot: 

I Scopefönstret, klicka på knappen Properties, fliken Data History och markera Save data 
to Workspace samt ange ett variabelnamn ( ex.vis A). Ändra Format till Array. Kör 
simuleringen. Om fönstret innehåller endast en graf, kommer A att bli en matris med två 
kolumner, en med x-värden och en med y-värden. Den kan plottas med detta kommando: 
>>plot ( A( : , 1) , A ( : , 2) ) 
 
Plotten kan därefter överföras till Word enligt tidigare beskrivning. 
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Simulink 
 

Simulink är ett tilläggsprogram för simulering och analys av dynamiska system, i första hand 
av teknisk natur. I en grafisk miljö kan man bygga upp exempelvis ett reglersystem och testa 
dess funktion genom att ändra ingående variabler och därefter studera den uppkomna 
utsignalen. 

 

Exempel 

 

För att få en inblick i hur programmet är uppbyggt, går vi igenom ett enkelt exempel: I 
modellen ska en sinusvåg integreras och visas på ett oscilloskop tillsammans med den 
ursprungliga signalen. 

Programmet startas från MatLab, antingen 
med en knapp eller med kommandot 
simulink. Då visas ett fönster som 
innehåller biblioteken med de olika 
symbolerna: 

 

Under Simulink visas underbiblioteken, 
vilka innehåller de olika komponenterna. 

Då ett underbibliotek markeras, visas 
respektive komponenter i det högra 
fönstret. 

Klicka på det vita arket för att få fram ett 
arbetsfönster. 

Symbolerna kan dras från biblioteks-
fönstret till arbetsfönstret. Inställningar för 
resp. komponent kan göras genom att 
dubbelklicka på symbolen. 

På motsvarande sätt infogas övriga 
symboler från biblioteken Sinks (Scope), 
Continuous (Integrator) och Signals and 
Systems (Mux = multiplexer). Den 
sistnämnda modulen fungerar som en 
telefonväxel och är till för att 
oscilloskopet ska kunna visa flera kurvor. 

Förbindelser mellan modulerna 
åstadkommes med hjälp av muspekaren genom "klicka och drag"-teknik (drag and drop). För 
att erhålla en förgreningspunkt på en ledning håller man nere Ctrl-tangenten samtidigt som 
man pekar på ledningen och trycker ner musknappen. 
 



Datoranvändning MatLab – Kort instruktion JPZ   
  (Ursprungligen för MatLab 6 av SBN/JKN) 

 120 

Schemat bör nu se ut så här: 
 

 
 

Före simulering bör man kontrollera och eventuellt ändra vissa parametrar i Simulation | 
Parameters. Grundinställning för simuleringstiden är 10 sekunder, vilket går att ändra här. 
Dessutom kan man få en tätare plottning av kurvorna genom att ändra på inställningarna för 
step size. I Solver Options kan man ange en annan simuleringstyp än den föreslagna, vilken 
dock brukar fungera bra. 
 
Dubbelklicka på Scope för att få upp 
visningsfönstret. Simuleringen startas med 
Simulation | Start. 

Genom att klicka på kikaren (autoscale) 
optimeras skalorna. Dessa kan ändras manuellt 
genom att högerklicka på respektive axel. 
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Övningar i MatLab 

Syfte 
 

Syftet med dessa övningar är att ge en introduktion till hur man arbetar med programsystemet 
MatLab så att du kan använda det i andra kurser. Det blir således inga matematiska 
djupdykningar, utan ett antal enkla exempel som förhoppningsvis ger dig grundläggande 
färdigheter i att använda programmet. Du bör inte enbart lösa uppgifterna här, utan pröva dig 
fram lite med hjälp av Getting Started i Helpdesk. 

 

Övning 1 
 

Börja med att skapa en mapp under M:\Pcsa med namnet Matlab. Starta därefter programmet 
via Links | Matematik | MatLab 6.5. 

När man vill definiera en matris i MatLab kan man skriva på flera olika sätt. 

 

 
a) Mata in matrisen A: 
 
b) Genom att placera om elementen i matrisen ovan, kan man skapa en s.k. magisk 

kvadrat, som har egenskapen att summan av varje rad, kolumn respektive diagonal blir 
densamma (=15). 

 
I MatLab kan du åstadkomma en sådan med kommandot magic(3). Prova! 

 
c) Vilka variabler ”är i gång” nu? Använd kommandot who. 
 
d) Skapa matrisen B genom att multiplicera A med 3. Kontrollera resultatet. 
 
e) Skapa matrisen C genom att addera A och B. 
 
f) Använd syntaxen C(r,k) för att plocka ut 1) mittenelementet, 2) första kolumnen och 3) 

andra raden från C. Använd : för att ange exempelvis alla rader. 
 
g) Skapa en vektor med 10 slumptal, använd rand(r,k). Plotta vektorn. Undersök också 

hur man sätter rubriker på axlarna. (Använd rand('state',sum(100*clock)) för att göra 
reset av slumtalsgeneratorn och sätta ett frö.) 

 
h) Plotta funktionen y = sin 4x * e -0,2x som i Matlab skrivs:  sin(4*x) .* exp(-0.2*x) , för x i 

intervallet 0 till 10. Använd kommandot fplot (se teoridelen!). 
 
 

Övningarna 1a-1f ska inte redovisas. 

⎟
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Övning 2 
 

Det finns två sätt att arbeta med MatLab. Vanligen arbetar man interaktivt - man skriver ett 
kommando och får direkt ett svar osv. Men om man skall göra komplicerade beräkningar så är 
risken stor att man skriver fel någonstans. Det är då bra om man kan förbereda MatLab-
kommandon i en vanlig fil (med hjälp av en editor), vilken sedan läses in i MatLab. Man 
skapar filen lämpligtvis med den inbyggda editorn (startas med edit), sparar den (i 
M:\Pcsa\Matlab) med ett namn som slutar på .m, tex abc.m, och kan sedan använda den inuti 
MatLab genom anropet abc. MatLab kommer då att läsa in filen och exekvera de kommandon 
som står där, precis som om man skrivit dem interaktivt. Denna typ av filer kallas 
kommandoscript eller m-filer.  

 

Skapa ett kommandoscript som skriver ut en tabell med sinusvärden för x-värden i intervallet 
0 till 2π och därefter ritar grafen automatiskt. Tips: Kommandot [x y] skriver ut variablerna 
"parvis" under förutsättning att x och y är kolumnvektorer. Kalla filen finuf.m. Redovisa 
script och diagram till Word. Diagrammet ska ha rubriker och rutnät. 

 

Tips: 
x=[0:pi/5:2*pi]';  %( '-tecknet gör radvektorn till en kolumnvektor) 
y=sin(x); 
[x  y] 
etc… 
 
OBS. Du ska inte använda fplot. 
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Övning 3 
 

Ge nedanstående kommandon i MatLabs kommandofönster. Först skapar vi ett antal polära 
koordinatpar i enhetscirkeln. 
>> [th,r] = meshgrid((0:5:360)*pi/180,0:.05:1);  %Polära koordinater 
 
Sedan omvandlar vi dessa till kartesiska koordinater istället. 
>> [X,Y] = pol2cart(th,r);   %Omvandling till kartesiska koordinater 
>> Z = X+i*Y;                %Matris med komplexa tal 
>> f = Z.^2;                 %En komplexvärd funktion 
>> surf(X,Y,abs(f))          %En plot av f:s absolutbelopp 
>> axis square               %Snyggar till proportionerna 
 
Ibland kan det vara svårt att se hur figuren egentligen ser ut. Välj då Tools | Rotate 3D. Flytta 
musmarkören in i figuren och tryck ned vänstermusknapp. Håll knappen nedtryckt och dra 
sedan runt med figuren. Välj sedan Insert | Title och skriv in abs(Z^2). 

Genom att ändra den 4:e raden och återupprepa rad 5 och 6 kan man nu göra nya figurer. 
>> f = Z.^(-1/2);               %En annan komplexvärd funktion 
 
Gör även figurer för dessa funktioner: 
f = sin(Z) och f = Z.^3-Z.^2+Z-1 
 
Redovisa alla fyra figurerna med förklarande text. 

 

Övning 4 
 
Följande rad är en MatLabdefinition. Skriv den på "vanligt" sätt dvs med traditionell 
matematisk syntax med hjälp av Equation Editor i Word, redovisa! 
 
y = 1 ./ ((x - .3) .^ 2+ .01) + 1./ ((x - .9) .^ 2+ .04) - 2; 
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Övning 5 – Dämpad sinussvängning 
 

Använd programmet Simulink för att åstadkomma en dämpad sinussvängning. Det 
matematiska uttrycket för en sådan kan skrivas 

bxey ax sin⋅=  
 

med lämpliga värden på a och b. 
 
Tips: Använd blocken i figuren nedan. Konstanterna a och b är här valda till -1 resp. 20. 

 

 
 

Ändra i Simulation parameters så att nedanstående graf erhålles. Figuren är överförd med 
metod 1 och redigerad i LviewPro. 

 

 
 

OBS. Se till så att kurvan inte blir hackig. 

 

Redovisa i Word. Blockschemat läggs i Urklipp med Edit | Copy Model. 
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Övning 6 – Vattennivån i en tank 
 

I en vattentank enligt figur är nivån från början h0. Genom utloppet (area A1) i botten 
strömmar vattnet med farten v där 

hgv ⋅⋅= 2   g = tyngdacc. 

 

Tankens bottenarea är A0. Från en kran tappas vatten i tanken med det konstanta flödet k m3/s. 

Volymen som funktion av tiden kan tecknas: 

tghAtkAhV ⋅⋅−⋅+⋅= 2100  
 
 

Eftersom hAV ⋅= 0 , fås höjden som funktion av tiden: 

tgh
A
At

A
khh ⋅⋅−⋅+= 2

0

1

0
0  

 

 

Sambandet ovan kan simuleras med hjälp av nedanstående block. Konstruera blockschemat 
och kör simuleringen med värden från nedanstående tabell. Välj samma ordningsnummer i 
tabellen nedan som för polynomet i de tidigare uppgifterna. 

 

Blockdiagrammet och grafen ska redovisas (tillsammans med de övriga 
datoranvändningsövningarna). Grafen ska sträcka sig så långt att ett eventuellt jämviktsläge 
framgår. Redovisa även en beräkning av detta jämviktsläge. 

 

 
 
 
 
 
 

v

A1 

A0 

h 

k 
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Ramp
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Math
Function

2

Gain2
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Gain1

20

GainDot Product
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Nr h0 (m) A0 (m2) A1 (m2) k (m3/s)
1 3,0 4,0 0,2 0,4 
2 3,5 2,0 0,1 0,2 
3 1,5 2,5 0,3 0,5 
4 4,0 3,0 0,15 0,1 
5 1,0 5,0 0,3 0,3 
6 2,0 1,0 0,5 0,1 
7 3,5 3,5 0,4 0,6 
8 6,0 0,5 0,1 0,2 
9 2,5 2,0 0,05 0,1 
10 0,5 4,0 0,2 0,3 
11 1,0 3,5 0,5 1,2 
12 5,0 2,5 0,25 0,8 
13 3,0 6,0 0,1 0,5 
14 4,5 3,0 0,25 1,0 
15 1,0 0,5 0,05 0,2 
16 4,5 6,0 0,1 0,8 
17 2,0 3,0 0,05 0,5 
18 4,0 2,0 0,2 0,3 
19 2,0 1,0 0,1 1,1 
20 8,0 0,5 0,1 0,2 
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Maya  (OH) 
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Övningar i Maya 
 

Modellering 
 
Börja med att skapa en arbetskatalog för Maya i din hemkatalog M:\PCSA. Visserligen 
kommer Maya att skapa en katalog i My Documents men egna dokument bör sparas så att de 
kan öppnas från andra datorer på nätet. 
 
Gör sedan övningen Modeling a polygonal mesh. 
 

1. Öppna Getting Started with Maya (GSWM) som finns i Help-menyn och ta fram 
innehållet. 
 
Help → Tutorials → Visa Navigering 
 
Denna startpunkt kallas i fortsättningen GSWM. 
 
 

2. Läs igenom introduktionen. 
 
GSWM → Polygonal Modeling → Introduction 
 
 

3. Gör de förberedande inställningarna. 
 
GSWM → Polygonal Modeling → Preparing for the lesson 
 
 

4. Följ anvisningarna för Lesson 1 Modeling a polygonal mesh. 
 
GSWM → Polygonal Modeling → Lesson 1 Modeling a polygonal mesh  → 
Introduction 
 
Gå igenom alla avsnitt till denna lektion och utför övningarna. 
 
Bildfilerna  HelmetFront.jpg och HelmetSide.jpg finns på kurssidan (Blackboard). 
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Animering 
 
 
Om du får tid över, är ett förslag att du gör en animering (icke-linjär med Trax). Gör så här: 
 

1. Läs igenom introduktionen. 
 
GSWM → Animation → Introduction 
 
 

2. Gör de förberedande inställningarna. 
 
GSWM → Animation → Preparing for the lessons 
 
 

3. Följ anvisningarna för Lesson 4 Nonlinear animation with Trax. 
 
GSWM → Animation → Lesson 4 Nonlinear animation with Trax → Introduction 
 
Gå igenom alla avsnitt till denna lektion och utför övningarna. 
 
Projektfilerna (scenerna)  Trax_Lession1.ma, Bank_Left.ma och 
Trax_Lession2.ma finns på kurssidan (Blackboard). (Om inte respektive .ma finns, 
används istället .mb.) 

 
 
Du kommer troligtvis inte att hinna hela övningen under lektionstid, men i mån av intresse 
kan den slutföras på egen tid. 
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Redovisning 
 
Sätt samman dina övningar och lösningar till uppgifter i följande ordning. Häfta ihop sidorna 
till ett häfte. 
 

1. Försättsbladet från Word-övningen 3:2. Fyll i rubrik, kort sammanfattning, kurs och 
namn. 
 

2. Word-övningen 1 
 

3. Word-övningen 2 
 

4. Word-övningen 3:3 
 

5. Din presentation från PowerPoint-övningen (åhörarkopia, utskrift med tre bilder per 
sida). 

 
6. Excel-övningen 1 (alla bladen i arbetsboken för Formfaktor) 

 
7. Excel-övningen 2 

 
8. Endast för SDT1: Python-övningarna A:1-4 (obligatoriska) 

Endast för B1, IDP1 och M1: MatLab-övningarna 1g, 1h och 2-6. 
 

9. Endast för SDT1: Python-övningarna B:1-3 (valfria) 
 

10. Endast för SDT1: Maya-övningarna redovisas inte skriftligen. 
 
 
Häftet lämnas in senast    
 
Skriv övningslärarens namn på häftet och lägg det i den vita brevlådan utanför ACT. 
 

 
 

 




